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1. The INDOT CAD Workspace in ProjectWise

INDOT delivers workspace resources to the majority of INDOT employees using a ProjectWise Managed
workspace. The following section covers a very high-level overview of what resources are directly
available, and the usage experience that can be expected. These resources drive the INDOT specific
tools, workflows, and resources that will be covered throughout the remainder of the MicroStation

Platform Ul discussion later in this module.

1.1 CAD Seed/Template Files

There are several seed/template files that are used to provide the foundation for the many types of CAD
files that INDOT uses. These files can be found in the ORD-CONNECT Seed folder in ProjectWise under

Template Documents.
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pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5C

Contained within this folder are several seed files that are categorized by the different use cases for
them.

& | DWG Creation Seed Files
| Real Estate Seed Files (2D only)
# = Sheets

& | Standards Seed Files

FIE Survey Seed Files

# & INDOT_US_SVFT_2Dseed.dgn
# % JINDOT_US_SVFT_3Dseed.dgn

Contents of ORD-Connect Seed Folder

The remainder of this section will give a brief description of these seed files.

1.1-1 INDOT_US_SVFT Seed Files
The INDOT_US_SVFT seed files are the most commonly used seed files in the plans production process.
The 2D version is often used by the Design group to create the foundation for their design files, while
the 3D version is often used by the Survey group as the foundation for displaying their survey data to
designers in CAD form.

1.1-2 DWG Creation Seed Files
The seed files contained within the DWG Creation Seed Files folder assist the user when working with
AutoCAD DWG files. If a DWG file needs to be created directly, a seed.dwg file is provided. If a DGN file
needs to be created to bring in AutoCAD data into it, the various “transeed” seed files are provided.

Mame

# | seed.dwg
_,/Ejtranseed.dgn

# & Jtranseed_Us.dgn
/E]transeed_US_S‘-ﬂ-—l'.dgn

DWG Creation Seed Files

1.1-3 Real Estate Seed Files (2D only)

The Real Estate Seed Files folder contains the seed files most often used specifically by the Real Estate
group.

/& JINDOT_US_2Dseed.dgn
# & dNDOT_US_SVFT_2Dseed.dgn
.,/EJ Parcel_Plat_Ternplates.dgn

Real Estate Seed Files (2D only)


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CDWG%20Creation%20Seed%20Files%5Cseed.dwg

1.1-4 Sheets
The Sheets folder contains the seed files used to create plan sheets. The
INDOT US SVFT 2D Drawing Seed file is the base seed file for a drawing model, while the
INDOT US SVFT 2D Sheet Seed file is the base seed file for a sheet model. Note that you should
rarely have to use these seed files in this form—as they are already built into the sheet seeds that are
utilized in the plans production process.

# & 4INDOT_US_SVFT_2D_Drawing_Seed.dgn
# & JINDOT_US_SVFT_2D_Sheet_Seed.dgn

Sheets Seed Files

1.1-5 Standards Seed Files
The Standards Seed Files folder contains the seed files specifically used by the Standards group. The file
is used for the creation of content for the Design Manual, and the Standards Seed2D file is used for the
creation of standard drawings.

jE]Design_Manual Seed2D.dgn
,)E]Standards_SeedED.dgn

Standards Seed Files

1.1-6 Survey Seed Files
The Survey Seed Files folder contains the seed files most commonly used by the Survey group. The
esri_cad.wld and IN_GeoCS.dty files assist the Survey group in applying geocoordination to their survey
data, while the file assists the Survey in creating content for route plats.

_/_"l esri_cad.wlid
| IN_GeoCS.dty
jﬂ routeplat_US SVFT.dgn

Survey Seed Files

1.2 Revised Template Sheet Models

All INDOT CAD sheet models have been split into 2 separate files:

D size sheets.dgn : All 24 x 36 (D size) sheet models now reside in this design file.

Ltr_sheets.dgn: All 8.5 x 11 (letter size) sheet models now reside in this design file.

In addition to separating the large format sheet models from the smaller ones, MicroStation’s ability to
convert units on the fly has allowed for the metric versions of these sheet models to be removed.


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CSheets%5CINDOT_US_SVFT_2D_Drawing_Seed.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CSheets%5CINDOT_US_SVFT_2D_Sheet_Seed.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CStandards%20Seed%20Files%5CStandards_Seed2D.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CSurvey%20Seed%20Files%5Cesri_cad.wld
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CSurvey%20Seed%20Files%5CIN_GeoCS.dty
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CDGN%5CD%20size_sheets.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CDGN%5CLtr_sheets.dgn

1.3 The ProjectWise Managed Workspace

The Managed Workspace is a feature of ProjectWise that allows MicroStation workspace files to be
managed within the ProjectWise environment. The benefits of doing this are that all workspace files are
located and administered in a single location. This allows for the rapid deployment of updates and
changes, while allowing flexibility in what and how workspace resources are accessed.

Note: Be aware that if you are working outside of ProjectWise or if you’re an external user, and are
not using the INDOT Standalone Workspace, you will not have access to our managed workspace. As
such, the INDOT-specific tools, levels, and customizations will not be available to you.

1.3-1 Managed Workspace Export
The managed workspace attaches itself to any document opened by a MicroStation based application
(MicroStation, OpenRoads Designer, etc.) from within ProjectWise. You can expect the managed
workspace to be active when viewing/editing DGNs, DWGs, DXFs or any other file ProjectWise opens
with a MicroStation based application such as OpenRoads Designer.

When opening CAD files from ProjectWise for the first time, you will see the following.

Managed Workspace Export Progress D!

COverall progress: Close

[ Close dialog in 4 second(s)

Task Status

Gathering configuration settings blocks Complete
Creating temporary configuration files Complete
Gathering data for configuration flles Complete
Resolving relative paths Complete
Checking status and downloading workspace documents Complete
Checking status and downloading workspace folders and data Complete
Generating final warkspace confiquration file Complete

Managed Workspace Export Dialog

This is the Managed Workspace Export Progress dialog, and it shows the status of ProjectWise placing
the workspace in your working folders. The first time you open a CAD file after the workspace has been
initialized, this dialog will take a short amount of time to download all the relevant files and configure
your workstation for the first time.

Subsequent file opens will reduce the amount of time required for the export to complete—as once the
files have been downloaded, ProjectWise will only update them if there has been a change at the server.
This ensures that you always have the most up-to-date workspace files available.



1.3-2 Working with the Workspace
Day-to-day use of the workspace has not changed in a visible manner. All toolboxes, macros, and
symbology resources have been updated to automatically be available when you access your files.
Areas where you may see differences are in the file paths where items such as cells are being attached
from, or where you are initially directed to attach other resources.

1.3-3 INDOT Customized Fonts
With the release of MicroStation V8i, Bentley no longer provides a method of maintaining and further
customizing font resource files. Due to this limitation, INDOT customized fonts have been discontinued
and we have instead moved to using true type fonts only. The benefits of this method are that files will
seamlessly translate between CAD packages, and this will prevent the various other issues such as text
rendering improperly or with the wrong character set.

As such, the Office of Standards and Policy has provided CAD tech notes on how the special character
cells that have been instituted as their replacement should be used in conjunction with the True Type
fonts.

1.3-4 MicroStation and Files with SignCAD Fonts
With the removal of the legacy INDOT font resource file, the managed workspace is now configured to
have the SignCAD fonts available on every project as there is no longer a conflict with existing resources.

1.3-5 The MicroStation Platform, File -> Open and Workspace Reloads
When opening files from the File -> Open command in a MicroStation platform product, you may be
prompted with the following dialog:

Alert

MicroStation must be restarted to load workspace data
? for the new workspace cenfiguration.
Do you want to restart now?

fes

E

Managed Workspace Prompt when Switching Files

This dialog denotes that there is a difference between the workspace you currently have loaded and the
workspace options for the file you are attempting to open (most commonly a file based, reference path
will change). In most instances the user can safely select No to proceed to their next file as most files
now share the same workspace. One should consider selecting Yes, however, if they are switching from
a MicroStation to an InRoads associated file. This would be necessary so that the appropriate civil
resources are loaded for these legacy file types and their associated operations.

1.3-6 Text Styles
This section will give an introductory description of what a MicroStation-based text style comprises, and
then will cover the text styles that are currently included in the INDOT managed workspace.
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1.3-6a What is a Text Style?
MicroStation supports text styles and provides an interface for constructing text using available system
fonts and a wide variety of text attributes. A text style comprises a group of text attributes, such as font
type, width, height, and color. Text styles enable you to place text within a model in a consistent and
automated manner.

The following fonts are supported natively in MicroStation:

e Traditional MicroStation fonts
o TrueType fonts
e AutoCAD Shape fonts (.shx)

Tipl. Fonts are not embedded in the DGN file.

Tip2. If a Text Style changes in a Text Style library, Text Styles placed in DGN files prior to the change are
not automatically updated in the DGN files. To update a DGN file to reflect the changes in the Text Style
library, use the dgnlib to Update from Library from the text styles dialog.



1.3-6b INDOT Text Styles

INDOT has standardized the use of Tahoma font as the primary font used, except in limited
circumstances. You will notice that the text styles are now using only True Type fonts—which gives us
more flexibility with the Bold and Italics settings. The Bentley fonts will only be provided where
necessary and will not be available for new projects. The following tables will show you the base
settings for each text style provided as part of the INDOT Workspace.

Height | Width
Text Style Name Font ) 9 ) ! Notes/Guidelines for Use
(in.) (in.)

Text Styles for D-Size Plan Sheets

10 Point Text Tahoma 0.10 0.10 May be used for table data.

10 Point Text Arial Narrow | 0.10 | 0.10 | (€olor 225)

(Survey Text) Use for selected survey text.

Use for text callouts, dimensions, and

12 Point Text Tahoma 0.12 0.12 niotes. Minimum size for text |:.)I.aced on D-
size plans other than text specified under
10 Point Text.

14 Point Text Tahoma 0.14 0.14 Use for selected text on tlt|? blqck, view
subtitles, and column headings in tables.

14 Point Text Bookman Old 0.14 0.14 Use for parcel-owner text only.

(Property Owners) | Style

18 Point Text Tahoma 0.18 0.18 l{se for detall'and section titles, and table
titles on detail sheets.

30 Point Text Tahoma 0.30 0.30 Use for selected text on title sheet of plans.

. Used for annotation of GIS Required

GIS Annotation — .

. Tahoma 30 30 elements and provided for legacy

Full Size s
compatibility.

Text Styles for Ltr-Size Plan Sheets

5 Point Text Tahoma 0.05 0.05
May be used for table data, existing-grade

6 Point Text Tahoma 0.06 0.06 elevations on grid of plan and profile view,
and selected survey text.

Use for selected text on title block.

7 Point Text Tahoma 0.07 0.07 Column headings in tables, and parcel-
owner text.

7 Point Text Arial Narrow | 0.07 | 0.07 | (€olor 222)

(Survey Text) Use for selected survey text.

Use for text callouts, dimensions, notes,
column headings in tables, and parcel-

9 Point Text Tahoma 0.09 0.09 owner text. Minimum size for all text
placed on letter-size plans, other than text
specified under 6 Point Text.

12 Point Text Tahoma 0.12 0.12 Use for selected text on title sheet of plans.

14 Point Text Tahoma 0.14 0.14 Use for detail and section titles, and table

titles on detail sheets.

INDOT Text Styles




NOTES:

All styles are set to 0.65 (exact) line spacing.

All styles are Center-Center justified initially. Exceptions may exist for specific processes and are
listed in parentheses such as (LT) — Left Top, (LB) Left Bottom, etc.
All styles are non-bold and non-italic and should remain so unless indicated otherwise above.

Variations of the 10 Point, 12 Point, and 14 Point Text styles have been created from their base
text styles for use in annotation groups and/or civil labels.

(Values in the preceding chart are representative of a 1 to 1 scale)

There are additional styles provided from the Bentley default configuration. These named styles come
from other application sources and are not used in the INDOT workflow and should not be removed as

they are used as part of other default application configurations.

1.3-7 Dimension Styles and Settings

MicroStation dimension styles allow you to save dimension settings by name. This allows for greater
unity between groups of dimensions in the file, as several different styles can be used for various models
or portions of a model. Dimension styles are managed through the Dimension Styles Settings dialog

box.

Dimension Styles

Style (none)

¥ Arch

%% Arch Ltr

% Arch_Struc

¥ Boxed Text
+F Givil_Survey

[<# Engr Arrow |

5 Engr Arrow Civil Labeler
5 Engr Arrow Line

% Engr Arrow Line Ltr

5# Engr Arrow Ltr

< Engr Circle

% Engr Circle Civil Labeler
o+ Engr Circle Line

% Engr Circle Line Ltr

5 Engr Circle Ltr

% Engr None

¥ Engr None Ltr

¥ GIS Notation

¥ Legend Bubble Large

% Legend Bubble Small

%2 Plan Annotation with Arrowhead
2 Plan Annotation without Arrowhe
%# Standards Common

¥ Standards English

¥ Standards Metric

% Standards Note Circle
¥ Standards Note Diamond
¥ Standards Note Hex

% Standards Note NoBox
% Standards Note Square

< Standards Section

tH D=2 .5 X

Geometry Units Text Symbology Advanced

Style
Text Style: &y 12 Point Text -
N Font | (Tahoma) ~
[l Height: | 0.0100 _‘H_'
O Width: |0.0100 —
O Underline:  (0Ff) ~
Format
Orientation: | Aligned =
Location:  Above =
Justification: Center > Left <
Text Frame: | None =

Left Margin: | 0.500000

Lower Margin: | 0.500000

Stacked Fractions

O

Enable: |(On) -
Type: Diagonal =
Alignment: | Center =

Scale: | 1.000000

Dimension Styles

Notes
Leader Type: | Line
Terminator. | H—
Text Frame: | None
O Frame Scale: | 0.000000
In-line Leader: | 0.000000
Left Margin: | 0.000000
Lower Margin: |0.000000
Text Rotation: | Horizontal
Horizontal Attachment: | Auto
Edit About: | Top

FEEE

Xxx Yyy
Soooc Yyyyy

4« »




These dimension styles relate to the size of the text and are linked to the appropriate text style. The
following tables will show you the settings for each dimension style that is used in the plans production

process. Note: Values in the chart below are representative of a 1 to 1 scale.

Dimension Style Name

Text Style

Units

Notes / Settings

Dimension Styles for D-Size Plan Sheets

MU label-SU label,

Arrow terminator,

round to nearest 0.01

Arch 12 Point Text round to nearest 1/16 no text frame

. MU label-SU label, Arrow terminator,
Arch_Struc 30 Point Text round to nearest 1/16 no text frame
Engr Arrow 12 Point Text MU label, Arrow terminator,

no text frame

Engr Arrow Civil Labeler

12 Point Text

MU label, round to
nearest 0.01

Variation of Engr Arrow; used
in civil labels.

Engr Circle

12 Point Text

round to nearest 0.01

. . MU label, Arrow terminator,
Engr Arrow Line 12 Point Text .
round to nearest 0.01 line text frame
MU label, Circle terminator,

no text frame

Engr Circle Civil Labeler

12 Point Text

MU label, round to
nearest 0.01

Variation of Engr Circle; used in
civil labels

. . . MU label, Circle terminator,
Engr Circle Line 12 Point Text
round to nearest 0.01 no text frame
. MU label, No terminator,
Engr None 12 Point Text
round to nearest 0.01 no text frame
GIS .
. . MU label, Arrow terminator,
GIS Notation Annotation —
Eull Size round to nearest 0.01 no text frame

Dimension Styles for Ltr-Size Plan Sheets

MU label-SU label,

Arrow terminator,

round to nearest 0.01

Arch Ltr 9 Point Text
round to nearest 1/16 no text frame
. MU label, Arrow terminator,
Engr Arrow Ltr 9 Point Text round to nearest 0.01 no text frame
. . MU label, Arrow terminator,
Engr Arrow Line Ltr 9 Point Text .
round to nearest 0.01 line text frame
. . MU label, Circle terminator,
Engr Circle Ltr 9 Point Text
round to nearest 0.01 no text frame
. . . MU label, Circle terminator,
Engr Circle Line Ltr 9 Point Text
round to nearest 0.01 no text frame
. MU label, No terminator,
Engr None Ltr 9 Point Text

no text frame

NOTES:

All styles are set to use Working Units.

All styles are set to Dynamic Justify text notes.

3. There are additional styles available for other functionality such as civil labels. These are for

specific functionality and should not be used outside their specific areas.




1.3-8 Levels
In the current INDOT CAD production workspace, there are over 1250 levels. Due to this large number
of levels, level filters can be used to limit the level list ton only those levels needed. This section will
cover how the levels are categorized, and then how to create level filters based on these categories.

1.3-8a Level Classifications
With the large number of levels that now exist in the INDOT CAD Workspace, a level naming scheme has
been created to assist in filter creation—in addition to providing for consistent creation and
categorization of levels.

Example: P_RDWY_Guardrail

e P_ - First Position Prefix, indicates that the level contains information related to Proposed work

e RDWY_ - Second Position Prefix, indicates that the level contains information related to
Roadway Features

e Guardrail - Brief Description, indicates that the level contains line work specifically related to
Guardrail

The table on the following page lists the level classifications that are currently in use in our workspace:
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First Position | Description Second Position Description

G_ Ground Surface SURF_ Surface Features

P_ Proposed EW_ Earthworks Features

RW_ Right of Way HY_ Hydraulics Feature

S_ Survey (TOPO) RDWY _ Roadway Feature

XS_ Cross Section ALG_ Alignment

CG_ COGO Points BR_ Bridge Features

PROF_ Profile Features CTRL_ Survey Control

ST Standards Drawings DR_ Drainage Features

PP_ Plans Production PROP_ Property Features

BD Border RW_ Right of Way

Existing Features (non-

E_ Survey) TOPO_ Topographical Features

CcC_ Construction TRAF_ Traffic Features

XT_ Cross Section Template UTIL_ Utility Features

Draft_ Drafting Elements G_ Graphical Feature

Drain_ Drainage Elements TC_ Template Component

HY_ Hydraulics Features E_ Existing Feature

Road Roadway Barrier Elements OBJT_ Object (Standards Only)
ANNO _ Annotation (Standards Only)
REFR_ Reference (Standards Only)
TTLB_ Title Block (Standards Only)
TXT_ Text
SHT _ Sheet
TL_ Template Library
EC_ Erosion Control
PVMT _ Pavement
ENV_ Environmental Feature
MD_ Modeling

Level Classifications in INDOT CAD Workspace




1.3-8b Level Filters
Filters are a useful way to group associated levels for the purposes of viewing or not viewing as a group.
For example, you might have a DGN file with several hundred levels. Within these levels could be filters
for different disciplines such as Bridge and Traffic. Within Bridge there might be levels for proposed or
existing elements. You could easily define a filter called Bridge that would show only levels that would
be associated with Bridge work.

Filters can be named, saved, and recalled as needed or defined on-the-fly for immediate one-time
viewing using the Filter Row in the Level Manager dialog box. Filters can be turned on or off using the
Level Display dialog box. Filters can be used to turn on or off levels across a model and all its attached
models.

Levels can be filtered by several attributes such as filename, color, style, line weight, and level groups, to
name a few. To display the levels that are defined in a filter, select the Active Level filter button from
the Attributes toolbar and select the filter of choice. This will display those levels only and turn off all
other levels in the dgn. Note that the levels will not actually be turned on or off, but the ability to view
them in the Level Display will be dictated by the filter selected.

An updated set of level filters is available for use within the CAD Workspace. The table on the following
page explains the qualifications for these filters:
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Filter Name

Description

_IN Bridge

Level name contains _BR_

Bridge - Existing

Level name starts with S_BR_or E_BR_

Bridge - Proposed

Level name starts with P_BR_

_IN COGO

Level name starts with CG_

_IN Cross Section Components

Level name starts with XS_TC_

_IN Drainage

Level name contains _DR_

Drainage - Existing

Level name starts withS_ DR_or E_DR_

Drainage — Hydraulics

Level name starts with HY_DR_

Drainage - Proposed

Level name starts with P_DR_

_IN Erosion Control

Level name contains EC_

Erosion Control Proposed

Level name starts with P_EC_

_IN Rehab

Custom Level filter as specified by Bridge Rehab

_IN Right of Way

Level name contains RW_

Right of Way - Existing

Level name starts withS_ RW_or E_RW_

Right of Way - Proposed

Level name starts with RW_

_IN Roadway

Level name contains _RDWY _

Roadway - Existing

Level name starts with S_ RDWY_ or E_ RDWY _

Roadway - Proposed

Level name starts with P_RDWY _

_IN Sheet Component

Level name contains BD ,PP_, XS G_

Sheet Component - Border

Level name contains BD _

Sheet Component — Cross Section

Level name contains XS_G_

Sheet Component — Plans Production

Level name contains PP_

_IN Standards

Level name starts with ST_

_IN Survey

Level name starts with S_

Survey - Bridge

Level name starts with S_BR_

Survey - Drainage

Level name starts with S_DR_

Survey - Property

Level name starts with S_PROP_

Survey - Right of Way

Level name starts with S_RW_

Survey - Roadway

Level name starts with S_RDWY_

Survey - Surface

Level name starts with S_SURF_

Survey - Survey Control

Level name starts with S_CTRL_

Survey - TOPO

Level name starts with S_TOPO _

Survey - Traffic

Level name starts with S_TRAF_

Survey - Utilities

Level name starts with S_UTIL _

_IN Text Levels

Level names contain TXT, Text

_IN Traffic

Level names contain _TRAF_

Traffic — Existing

Level names start with E_TRAF_or S_TRAF_

Traffic — Proposed

Level names start with P_TRAF_

_IN Triangulation and Contours

Level name starts with G_SURF_

Level Filters in INDOT CAD Workspace




1.3-9 Worksets
Starting with the INDOTWise 5.1 Workspace, all projects configured for the MicroStation/OpenRoads
Designer 2023 platform in ProjectWise will now have access to a per-project INDOT_WS workset
definition. Instituting this functionality will allow for users to add items such as sheet indexing on a per-
project basis, along with the ability to add per-project customizations into their structure for use. Sheet
indexing will be discussed in a following section, and users wishing to add per-project customizations
should discuss this process with INDOT CAD Support before proceeding. End user intervention will not
be necessary to enable the workset functionality, as it will be applied at the creation of each project.
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2. MicroStation CONNECT Platform

The following materials cover what is new in the MicroStation CONNECT Platform. For most agency
users, OpenRoads Designer will be the product that provides the MicroStation Platform, and the
following information will apply across that product as well as others such as OpenCities Map Power
View. As this discussion covers the common components and interface updates from MicroStation,
these will be referred to as the MicroStation Platform. For a more in depth discussion of the changes to
the Ul and its functionality, please refer to the Bentley Learning Path: QuickStart for MicroStation
CONNECT.

2.1 What’s Different in the MicroStation CONNECT Platform

The current MicroStation platform has introduced many changes to the user interface compared to
previous versions. The goal of this chapter is to provide you with a guide to these interface changes and
some of the options that you will see.

2.1-1 Workflows
At the top left of the interface, there is a Workflow dialog. This dialog essentially replaces the Tasks
dialog that existed in previous versions. Each workflow contains all the necessary tools that are needed
to perform the functions it is created for. This section will cover the general layout of a workflow, and
some of the Ul functionality. Following this will be a discussion of the custom INDOT Workflow agency
specific settings and tools.

&l |Drawing MM HE P = p d. bentley.c dot-pw-0T\Documents\ 350\D ORD Pilot 7-7-22\0RD Pilot Sample With Sheets [2D - V8 DGN] - OpenRoads Designer

Home  View  Annotate  Attach  Analyze  Curves  Constraints  Utilties  DrawingAids  Content  Mesh  Collborate  Help
|5 N SETX 4 o PEATE A4 LS
N * | Defautt - - g & - -
@ None au Q B =~ Ve, o i = H x N oe-
o . Modify Create
% " Hem

1 = S0 - ~ [ | Explorer Attach _ Element nce Place Place _Arc Move Copy
EL @ 0 =0 @0 210 Tools~ 7~ T+ Selection Toolsw B~ Smariline Line Toolsw A~ A -

4
P
Attributes Primary Selection Placement Manipulate Madify Groups

) 0

FagE 3

Break  Tim .
ent Element Multiple "~ X Region ©

Drawing Workflow (all MicroStation Platform Products)

In the default setup of the INDOT Workspace, different workflows are visible depending on the product
that is currently in use. The list on the following page names each workflow, and the application(s) it is
associated with:


https://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=109567&aftkn=1475aceb-a027-4acc-af03-6f8771aa2130
https://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=109567&aftkn=1475aceb-a027-4acc-af03-6f8771aa2130
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Workflow Available in MicroStation | Available in OpenRoads Designer

OpenRoads Modeling X

OpenRoads Drawing Production

Survey

Geotechnical

Geospatial Context

Reality Modeling

X [ X | X [ X | X |[X

Drawing

General

Task Navigation

Modeling (3D files only)

Visualization (3D files only)

X | X [ X [ X | X | X |X[X

SignCAD (if installed)

Drainage and Utilities

X | X | X | X [ X

INDOT Tools X

Workflow Availability

2.1-1a Workflow Layout
Each workflow consists of a group of tabs in the Ribbon (like the Microsoft Office user interface) that
summarize the tasks needed to perform the workflow. Then, each tab contains “Groups” of tools that
perform those tasks. For example, to create a new corridor using OpenRoads Designer, the user would
navigate to the OpenRoads Modeling workflow, then the Corridors tab, and then the New Corridor tool
in the Create Group.

OpenRoadsModeling - | H ke « - + £ &2 - pw:\\dotwise.indot.in.gov:DOTWise\Documents\
Terrain Geometry Site Layout Drawing Production Drawing View
fe] ﬁ =% Copy Template Drop % g ? @ @ Define Target Aliasing ufu

Import IRD 5
e L Yig Imp Template bt tan. T @8 Comidor References ~ Tm

3~ | corridor [ Tran Template Drop  * & | Corridor Clipping

zl

Primary Selection Create Edit Miscellaneous

OpenRoads Modeling Workflow > Corridors tab > New Corridor

To assist with finding tools in this new interface, it is suggested to utilize the Search field in the top right
of the application window. As an example, say a user wants to search for where the tool is for creating a
terrain model from a file. The term “terrain” can be entered into the Search field, and the search results
will produce all the tools that have “terrain” in its name. Then to take it a step further, if the mouse
pointer is hovered over the search result, a list of navigation paths will appear that will—when clicked
on—take the user to the workflow where the tool resides and pre-select the tab where it resides.



|tErra|n‘ X v A

Ribbon (15)

am Create Terrain Model From File

Mavigate te OpenRoads Modeling—Home—~Medel Import/Export—Terrain Import

g Create Terrain Model From Ascii File

Ay Create Terrain Model From Elements
A Create Clipped Terrain Model
% Create Complex Terrain Madel

“ Create Terrain Model from Design Meshes
rad Label Terrain Contours

Iﬁ’ Label Terrain Spots

/8 Set Active Terrain Model

*) Create Terrain

7 Snap to Terrain

-

Show Details

M e ] e JVRAL T BA_ L)

Searching for Tools in OpenRoads Designer

As shown above, tools can often be found in more than one location, as certain tabs/tools are applicable
to more than one workflow—such as the Drawing and Drawing Production tabs, which are present in
several of the workflows.

Tool Dropdown Menus

Several tools in the MicroStation Platform interface have dropdown arrows adjacent to them—and
clicking on them will produce a menu showing various options. Below is an example of what happens
when the dropdown arrow adjacent to the Attach Tools button in the Primary Group is clicked:

8, Explorer [E| Reference = (@7 Properties
@ Attach Tools
@ References
] ﬁ Raster Manager
@ Point Clouds
Reality Mesh

ey Level Manager = Iﬁ Mare -

el Display ~

Attach Tools Dropdown

Be aware that some tools may just have a corresponding flyout menu associated with them, while
others—such as the Attach Tools dropdown shown above—have secondary tools listed in them.




2.1-1b INDOT Tools Workflow

The INDOT Tools workflow contains INDOT-specific tools that are specific to our workspace. From this

workflow, users can launch the AutoTurn application, add title block integration, connect to our cell
libraries, among many other tasks.

4| INDOT Tools @A OHERer A S
[ Home  Applications & Tools  Cells  AnnotationTools  Survey  Traffic
} =] A= =
Z |None * || Default = Q a- Q p /OD/.-iﬂ - - - US Survey Foot v | = - '}
------- Custom ACS

= =0 - = | Explorer Attach s w d z Ft v - Select by

B0 =0 =0 @0 4o plorer ogis - @- ow Zoom \Fit S\ [ Orentation = pric, ot [USSumey inch W= g
Atributes

ele
1"=30 Active Level
Primary Tools

INDOT Tools Workflow

Each entry in the ribbon will be discussed in the following sections. What you will find is a mix of tools

preconfigured settings, and utility launchers that correspond to several functions specific to the INDOT
CAD Workspace.

Applications & Tools

=1 INDOT Tools ~@EA-oHdHER -2 22 -

Home Applications & Tools Cells Annoctation Tocls Survey Traffic

~ ®OF ® &

Run Change Launch Title Block Title LineStyle Show Civil
Direction Tool AutoTurn | Integration... Block Update Re-Import Schema Info

Applications ProjectWise Integration

Line5tyle Re-lmport | Civil 5chemna

The Applications & Tools Ribbon

On the Applications & Tools ribbon you can find a series of small tools and launchers for the following

e Run Change Direction Tool — Used to change the direction of base MicroStation Platform

elements, this should not be run on elements created with any Civil data such as alignments
there are dedicated tools for these functions where necessary.

Launch AutoTurn — Used to launch the AutoTurn turning radius application that runs within the
MicroStation Platform.

NOTE: There are a couple important items to keep in mind when launching AutoTurn. First, to launch
AutoTurn, you MUST first be connected to the state network (in office or via VPN if remote) to connect to
our AutoTurn licensing. If you are not connected to the state network, you will receive an error message
indicating that the application was not able to obtain the necessary licensing. Second, once AutoTurn is
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successfully launched, you must then go to the Drawing workflow, where you will find the AutoTurn tab
containing the AutoTurn tools.

E‘ Drawing hE - S H h:; Eho - - * g = pw:i\indot- pw.bentley.com:indot-pw-01\Documents\_Testing\Dynamic Workspace - ORD DeviDesign\Op
Home View Annotate Attach Analyze Curves Constraints Utilities Drawing Aids Content Mesh AutoTURN ‘ Collaborate Help

Q% Q é{j’ 29 Generate Cormer Path \(\& = @'\,‘@i;qf . m @?l}j b o @ °

7 Qversteer Camner Path

Settings Properties Vehicles = Generate Adaptive  Vertical path .~ Sight = Animate Insert Convert IntelliPath = Tuterials Technical
Arc Path Simulation Simulation = Centrol 0 Lines Profile 2Dto 3D Support
Configure SmartPaths Place Edit Analyze Visualize Repaort Preview Support

Explorer v i x

[==1

B View 1, Default

AutoTURN Tab in Drawing Workflow

o Title Block Integration Cell — Used to directly attach the cell library for the cells used for title
block tags. This should only be used in conjunction with the CAD Support team as multiple
placements of these cells can cause issues when title block text is resolved from ProjectWise.

e Title Block Update — Used to update the title block of plan sheets with the latest project
attributes pulled from ProjectWise.

e LineStyle Re-Import — Used to re-import line styles from our source RSC file that have become
corrupted in your current file.

e Show Civil Schema Info — Used to display the civil schema information for the ORD application
you’re working with.

Cells

Ed INDOT Tools @ S H .'._::; Ea - ’ g = pw:\lindot-pw.bentley.comiind ot-pw-01\Documents'_Testing'\Dynamic

- > o
So® B 50O

File Home Applications & Tools Cells Annotation Tools Survey Traffic

¥ WM B M ReH

Place Set Coun Imperial Metric  Lighting Signals Patterns  Pavement Signs  Symbaol Scale Tables-Legend-Notes MOT Professional
Cell Tool Active Scale=1 | District Maps Detail Cells Detail Cells ells - Library Cells  Markings Cells Cells™ "Cells  Bars ells Cells  Stamps
Cell Tools Cell Libraries

The Cells Ribbon

On the cells ribbon, you can find the following cell related options:

e Place Cell Tool — Launches the MicroStation Platform Place Cell dialog with the currently active
cell library.

e Set Active Scale=1 — Sets the active scale for the current model to 1 for the X,Y, an Z coordinates.
All cell placement relies on these scales, and this allows to quickly reset depending on need.

e Country District Maps — Attaches the county and district map library for use on title sheets.

o Imperial Detail Cells — Legacy design detail cells in imperial units. Note that these are provided
as reference from prior versions of the CAD workspace and elements/styles may not adhere to
current workspace conventions.



e Metric Detail Cells — Legacy design detail cells in metric units. Note that these are provided as
reference from prior versions of the CAD workspace and elements/styles may not adhere to
current workspace conventions.

e Lighting Cells — Cells primarily used for sign, signals, and lighting plans.

e Patterns Cells — Basic pattern cells used for filled shapes.

e Pavement Markings Cells — Cells used to place pavement markings.

e Signs Cells — Cell libraries of agency signage used to place signs without necessitating the usage
of SignCAD. A dropdown menu of the various libraries is available to attach specific categories.

Applications & Tools Annotation Tools Survey Traffic
- ENG MET I ] D

Coun Imperial Metric  Lighting Signals Patterns  Pav
==1  District Maps Detail Cells Detail Cells ells " Library Cells M

oM B 4 ©

Signs wmbol Scale Tables-Legend-Motes MOT Professional
Cells= | F'Cells  Bars ells Cells  Stamps

ell Libraries’ Regulatory Signs

Warning Signs 5 f Q)

Guide Signs
School and Object Marker Signs =
' TLeeOOwd

Construction Signs

‘ Y [320175.4302 @ No Feature Defintion

+
| J
&
\ 4
=

Recreational Signs

Signs Cells Dropdown Menu

e Symbol Cells — Common drafting symbols

e Scale Bars — A variety of preconfigured scale bars.

e Tables-Legends-Notes Cells — Mixed text/table components created for placement on CAD
drawings.

e MOT Cells — Maintenance of Traffic cells

e Professional Stamps — Agency PE stamps for quick placement. Agency users only.

Annotation Tools

=] INDOT Tools ~@rodERe 2 85 -
Home Applications & Tools Cells Annoctation Tocls Survey Traffic
A S &
T A AA
e Cﬂ‘ i ¢ e @
Place Change Align Letter _Full Benchin
Text Along Case Elements By Edge Size~  Size~ Table Ce

Text Tools Annctation Styles | Benching Table

The Annotation Tools Ribbon




The Annotation Tools ribbon contains the following items:

e Place Text Along — Allows for the placement of text along a MicroStation Platform adjusting its
orientation to follow the element path.

e Change Case — Quickly change the case of already placed text.

e Align Elements By Edge — Allows for the alignment of multiple CAD elements to align to another
existing element. Commonly use with items such as station offset annotations to align text to
the border frame.

e Annotation Styles Letter and Full Size — These are a series of prebuilt annotations using the place
note and place text tools using workspace text styles, dimension styles, and symbology.

Cells Annotation Tools Survey Traffic

A A
Letter  Full &
Sizev Sizew

_ Annotatii -A place Note

Fa  Begin/End Project Mote

2
:I +) @ :::" Construction Limits Notes
¥, Ditch Elevations Left
;'-A Ditch Elevations Right
% Ditch Notes Left

i Ditch Motes Right
& Driveways

Za Pl Monument

F&  Pipes (Plan View)

#&  Pipes (Profile View - Left)

#& Pipes (Profile View - Right)
A POT/POC Monument

>4 Right of Way MNotes

#4 Right of Way Points

%a  Section Line Note

Fa  Section Monument

#a  Station Equations (Existing)

Ea  Station Equations (Proposed)

Letter Size and Full Size Dropdown Menus

e Benching Table Cell — Places the optional Benching Table Cell on End Area Volume Tables on
Cross Sections.



Survey

%] INDOTTools IERE=] - | TS N =

File Home Applications & Tools Cells Annotation Tools Survey Traffic

JSAAE @ ®©A

Place Place Place | Graphic Survey Survey LS Survey
Line Text Mote Scale Topo Symbels Meonuments Stamps Cells

Cuick Tools Cell Tools

The Survey Ribbon

The following can be found on the Survey ribbon:

e Place Line, Text and Note — These are the base MicroStation Platform commands placed for
quick access.

e  Graphic Scale — Survey specific scale bar cells.

e Survey Topo Symbols — Cell library containing survey TOPO symbols for manual placement.

e Survey Monuments - Cell library containing survey monument symbols for manual placement.

e LS Stamps - Agency LS stamps for quick placement. Agency users only.

e Survey Cells — Survey sheet and reference card components for placement as cells.

Traffic

=] INDOT Tools @B oHdEB e 22

File Home Applications & Tools Cells Annotation Tools Survey Traffic

I'fa ] sto-f | = H

Lighhting Signals 3igns Pavement Symbols Tables-Legend-Motes_Tra... Launch
Library Library ¥  Markings Library Library AutoTurn
Cells Turning Paths

The Traffic Ribbon

In the Traffic Ribbon you can find the following items:

e Lighting Library — Cells specific to lighting operations.

e Signals Library — Cells specific to signals operations.

e Signs —Signage cell libraries, please see the earlier section on Cells ribbon for more detail.

e Pavement Markings Library — Cells used to place pavement markings.

e Symbol Cells — Common drafting symbols

e Tables-Legends-Notes Cells — Mixed text/table components created for placement on CAD
drawings.



e launch AutoTurn — Used to launch the AutoTurn turning radius application that runs within the
MicroStation Platform.

NOTE: There are a couple important items to keep in mind when launching AutoTurn. First, in order to
launch AutoTurn, you MUST first be connected to the state network to connect to our AutoTurn licensing.
If you are not connected to the state network, you will receive an error message indicating that the
application was not able to obtain the necessary licensing. Second, once AutoTurn is successfully
launched, you must then go to the Drawing workflow, where you will find the AutoTURN tab containing
the AutoTurn tools.
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E’] | Drawing E S H l'Ld EE: LN ‘ lQJ s pw:i\indot- pw.bentley.com:indot-pw-01\Documents\_Testing\Dynamic Workspace - ORD DeviDesign\Op
File Home View Annotate Attach Analyze Curves Constraints Utilities Drawing Aids Content Mesh AutoTURN Collaborate Help

A Q@ Fremenn @ m Wil e [ BT H w0

Settings Properties Vehicles = Generate Adaptive  Vertical Path Sight = Animate In;art Conver‘t IntelliPath = Tutorials Technical
Arc Path Simulation Simulation = Centrol O Lines Profile 2D to 3D Support
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Explorer

AutoTURN Tab in Drawing Workflow
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2.1-1c The SignCAD Workflow
The SignCAD workflows is a single ribbon of 4 commands. These all relate to the placement of SignCAD
signs within the MicroStation Platform.

& [siancap .

IS sioncao
W Ij

Open Place OpenRoads Paste
SignCAD File SignCAD File  SignCAD  SignCAD File

SignCAD

'__[>

The SignCAD Workflow/Ribbon

e Open SignCAD File — Opens a SignCAD file (.sgn) and creates a new DGN of it.

e Place SignCAD File — Places a SignCAD file in the current model, like placing a cell.

e OpenRoads SignCAD — Opens SignCAD

e Paste SignCAD File — Configures settings for placement/conversion of SignCAD files into
MicroStation Platform.

2.1-1d OpenRoads Workflows
For a discussion of the additional workflows that are made available in OpenRoads Designer, please
refer to the DOTWise 5.0 ORD Plans Production Documentation which covers these tools along with
their usage.

2.1-2 Customizing the Ribbon Display
The Ribbon in the MicroStation Platform can be customized in several ways. One way to accomplish this
is to right-click anywhere within a Ribbon Group, which presents a menu with several options to
customize its display. The second way is to directly access the Customize Ribbon dialog, which is
discussed at the end of the section.
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2.1-2a Customizing the Tools Displayed in a Ribbon Group
The top section of the Ribbon Group’s menu lists all the tools that are associated with it.

QEge T Z L

Expl Attach El T Reports Civil
PO Tools » % G - SEFErEt?QH I v Analysis =
Primary Selertinn Maodel Analysis and R

v Explorer
l/\\;.tta ch Tools . Attach Tools
y Models e References

Reference Raster Manager

Level Manager L Point Clouds

Level Display E

Reality Mesh
Properties i

More

Pin/Unpin Group

Group Button Size

Customize Ribbon

Ribbon Group Tools

In the above example, a right-click within the Primary Ribbon Group presents a menu as shown. The
tools listed with a check mark next to them are already being displayed. As such, the tool display in the
Group can be turned on and off as desired.




2.1-2b Customizing the Display of Ribbon Groups
The Pin/Unpin Group option allows the user to pin (display) a Group in either a) every tab in all
workflows, or b) every tab in just the current workflow.

m “election Madel Anal
1 ¥ Explorer '
Attach Tools L
Madels LS
Reference L
Level Manager r
Level Display r
v Properties
Mare L :
+  Pin/Unpin Group  * Pin to all workflows
Group Button Size  * Pin to current workflow
Custemnize Ribbon Unpin

Pinning a Group to Workflows

Note that when a Group is pinned, it is placed on the left side of the Ribbon for each tab. Also note the
icon indicating that is pinned.

Home Terrain Geometry Site Layout
I‘%I‘ @ 8| | k Element Selectio
@1 .

Expl Attach
s Tools a5 ~ 'ﬁ | @

E!t Primary Primary Selection

Group is pinned to the current
workflow

—

Pinned Group

To unpin the Group, the user can either click on the icon as shown above or selecting the Unpin option
in the Ribbon Group’s menu.
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2.1-2c Customizing Button Sizes
To customize the button sizes in a Ribbon Group, navigate to the Group Button Size option in the Ribbon
Group’s menu and select the desired size: Small, Medium, or Large. To bring the sizes back to their
defaults, select the “Revert to default” option.

:\f Explorer Model Analys
Attach Tools r
Madels L
Reference r
Level Manager r
Level Display r
¥ Properties
Mare L

+  Pin/Unpin Group  *

Group Button Size  * Small

Customize Ribbon Medium

-L

Customizing Button Size in a Ribbon Group

2.1-2d The Customize Ribbon Dialog
Selecting Customize Ribbon from the Ribbon Group’s menu will open the Customize Ribbon dialog.

7]
Choose companents from: oo the isbor
Quick Access Toolbar (=) Buttons o 3
20 -
> Openfoads Madeling
Ely
> OpenRoads Drawing Production
/¢ 3D and B-spline
P > Survey
£ 30 Angle
i > Admin
[{) 3D Dimension X
> Geotechnical
¥ 3D Drive Through )
> Reality Modeling
# 3D Line Following
> Drawing
(€ About
- > Modeling
€% About Configuration . .
> Visualization
@ About Drainage and Utilities
4 SignCAD
(€% About OpenRoads Designer : i
> Drainage and Utilities
£ Accubraw
> INDOT Tools
% AccuDraw
CF:u AccuDraw Seftings Properties
% AccuSnap Settings No i
ACIS SAT
ACIS SAT
@ Actual Resolution (1:1)
A Add Annotation -
Custom Tools and Tasks Named Expressions Close

Customize Ribbon Dialog

NOTE: This can also be accessed by clicking on the File tab in the Ribbon and then clicking on Settings >
User > Customize Ribbon button.



From the Customize Ribbon dialog, a user can customize their Ribbon display by adding and/or removing
components (Ribbon Groups, tabs, individual buttons, etc.) to/from it. To add a component to the user
interface, the component first needs to be selected in the “Choose components from:” section of the
dialog. Then that component needs to be brought over to the desired location in the “Customize the
Ribbon:” section via click and drag. In the example below, the Analysis tab is being brought into the

INDOT Tools workflow.

ﬂ Customize Ribbon - Personal.dgnlib - m]
m Choose components from: Customize the Ribbon:
Quick Access Toolbar [T Tabs - -
> 713D Modeling - .
> | Drawing
|l B Analysis )
— P L1 Modeling
P () Analyze o
- > | Visualization
P ) Analyze .
- > | SignCAD
P ) Analyze .
- > | Drainage and Utilities
P [} Animate
- 4 | | INDOT Tocls
b [} Annotate —
_ » (! Home +
P [} Annotation Tools _ .
_ » (! Applications
b [} Applications —
_ > Cells
b [} Attach —
- » (! Annotation Tools
b [} Attach —
- » ! Survey
b [} Attach —
- > Traffic
Bl Cells
> [C! Components Properties
> [ Constraints No item has been selected
>[I} Content
> [T Corridors
> [T} Curves
> [ Deliver -
Custom Tocls and Tasks Named Expressions

Adding a Tab to a Workflow via Customize Ribbon Dialog

Once added, the INDOT Tools workflow and the Analysis tab both have a (Pending) designation in the

Customize the Ribbon section.

4 || INDOT Tools (Pending)

> [ Home

> [ Applications

> [ Cells

> [ Annotation Tools

> [ Survey -

Properties

Label Analysis -
Key Tip G
Visibility

Base Tab

4

Always

Pending Changes in Customize Ribbon Dialog




This is indicating that the changes being proposed are still pending. Click on the Apply button to confirm
the changes. After completion of processing, the Analysis tab is now added to the INDOT Tools
workflow.

E INDOT Tools = H l‘_x:g Ex:: * g. l;’l’,:, = pwi\\dotwise.indot.in.gov:DOTWise\Documentsh_Testing\0001350\Design’InRoads\ Old Testing Data\test\ORD PrPlar
File Home Analysis Applications Cells Annotation Tools Survey Traffic

% rﬂ 3 k i;‘;i [} = 3 Alternatives @ @ Validate ") Engineering Standards @ Compute Center % @ E_a Queries
E:‘ E‘Q Opticns E: Calculation Summary & Default Design Constraints =~ =

Explorer Attach properties  Element .. Scenarios Compute - Show Flex
Tools * Selection [} ~ E ~ O Notifications Guiter Flow | Tables

Primary Selection Calculation Analysis Tools Analysis Views

Analysis Tab Added to INDOT Tools Workflow

2.1-3 Customizing the Quick Access Toolbar
In much the same way as for the Ribbon, the Quick Access Toolbar—located next to the Workflow
dialog—can also be customized.

Eﬂ OpenRoads I\(hleling -

Quick Access Toolbar

Clicking on the button on the far right of the toolbar brings up a menu like that of a Ribbon Group’s
menu—to where the display of tools/options can be turned on and off as desired. Options are also
available to show the toolbar below the Ribbon, or to minimize the Ribbon entirely.
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pw:i\dotwise.indot.in.gov:DOT

r v Open on Drawing
¥ Save (1_' - 2
¥ Save Settings e

Il leports Civil
¥ Compress Options = Analysis

Undo v Undo |
¥ Redo % ¥ ToMark
¥ Set Mark v oAl
¥ Print

Element Selection

v Applications
Customize Quick Access ToolBar
Show Below the Ribbon
Minirnize the Ribbon

Quick Access Toolbar Menu

2.1-4 Dockable Dialogs

To gain more screen space, there are many dialogs that you can dock to the edges of the MicroStation
platform application window.

2.1-4a To Dock a Dockable Dialog
1. Select a dockable dialog's title bar. Most dialogs in the MicroStation platform can be docked,
and if they are able to, docking indicators like the below example will be displayed.

l
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=

Single Docking Indicator (Left) & Full Docking Indicator (Right)

2. Dragthe dialog over one of the docking indicators that appear in the center of the screen or
along the edges of the application window.



"

The docking indicator for the top docking region

3. Assoon as you begin to drag a dockable dialog, a transparent block representing the dialog is
attached to your pointer and moves with the pointer until you release the mouse button.

4. Place the pointer over one of the docking indicators. This highlights the available docking region
along the corresponding edge of the application window.

OpenRoads Model

& SheetIndex

Bottom Docking Indicator with Possible Docking Region

5. Release the mouse button. The dialog is docked within the selected docking region and is

displayed in its entirety.

2.1-4b To Turn on Auto Hide for a Docked Dialog
Dock a dockable dialog to an edge of the application window.
Click the Auto Hide (pushpin) icon in the upper-right corner of the docked dialog. The docked
dialog disappears, and a roll-out tab appears in its place along the same edge of the application
window.
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The Auto Hide (pushpin) icon
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Roll-out tabs for dialogs docked to left side of application window

2.1-4c To Turn off Auto Hide for a Docked Dialog
1. Place the pointer over a docked dialog's roll-out tab.
2. While the dialog is displayed, click the Auto Hide icon. The dialog is re-docked along the same

edge of the application window.

-=

The Auto Hide (pushpin icon

2.1-4d To Undock or Float a Docked Dialog
Double-click the title bar of a docked dialog. The dialog returns to the position in which it was last

floating.

2.1-4e To Re-dock a Floating Dockable Dialog
Double-click the title bar of a floating dockable dialog which has been docked at least once. The dialog
returns to the location where it was last docked.




2.1-4f To close a docked dialog
If the dialog is docked, simply click the dialog's Cancel icon (next to the Auto Hide icon). If Auto Hide is
enabled, first pause the pointer over a docked dialog's roll-out tab, then while the dialog is displayed,
click the dialog's Cancel icon, or simply enter the key-in that is normally used to close the dialog.

If you close a dialog while it is docked, and later click the icon or enter the key-in that normally opens
the dialog, the dialog will open again to the position it was last docked.

If a dialog is docked when MicroStation exits, it will be docked in the same position the next time you
start the product.

2.1-4qg List of Dockable Dialogs
The following is the list of dockable dialogs, and which edges they can be docked to:

e Tool Settings window (left or right)

e Element Information dialog (left or right)

e Project Explorer dialog (left or right)

e Link Sets dialog (left or right)

e Tasks dialog (left or right)

e  Markups dialog (left, right, top, or bottom)
e Item browser (left or right)

e Details dialog (left, right, top, or bottom)

e Feature Manager dialog (left or right)

e References dialog (top or bottom)

e Raster Manager dialog (top or bottom)

e Models dialog (top or bottom)

e Saved Views dialog (top or bottom)

e Level Manager dialog (top or bottom)

e Level Display dialog (left, right, top, or bottom)

The way in which you dock one of these dialogs is different from the way in which you dock a toolbox.



2.1-4h Using Docking Indicators
As you drag a dockable dialog, docking indicators appear on the screen. These docking indicators
indicate which edges of the application window the selected dialog can be docked to. In most cases, a
dockable dialog can only be docked either horizontally or vertically; however, some dialogs, like the
Level Display dialog, can be docked both horizontally and vertically.

—
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The center docking indicators

If the selected dialog can be docked horizontally, then the docking indicator at the center of the screen
will have arrows that point toward the top and bottom edges of the application window, and matching
docking indicators appear along the top and bottom edges. If the selected dialog can be docked
vertically, then the docking indicator at the center of the screen will have arrows that point toward the
left and right edges of the application window, and matching docking indicators appear along the left
and right edges.

=

The docking indicator for the top docking region

You can release the dialog over any of these arrows, and the dialog will be docked to the corresponding
docking region. While it is mostly a matter of preference whether you use the docking indicator at the
center of the screen or the ones at the edge of the application window, there is a slight difference in the
two.

Using the center docking indicators will position the dialog so that it takes up the remaining free space
along the length of the selected edge of the application window. For example, if there is already a dialog
that is docked vertically on the left edge of the application window, then dropping a horizontally docking
dialog over the center docking indicator, pointing toward the top edge of the application window, will
dock the dialog so that it fits in the remaining space along the top edge.

Using the docking indicators at the edges of the application window let you decide where specifically
along the selected edge you want to dock the dialog. For example, if there is already a dialog docked to



the left edge, you can use the edge docking indicators to select whether you want to dock the new
dialog on top of the existing dialog, or to the left or right of it, or above or below it.

If you are moving a dockable dialog and there are no dockable dialogs currently docked to the edge of
the application window that the selected dialog can be docked to, then the center controls will not
display.

2.1-4i Other Dialogs that can be Docked
The following dialogs are also dockable; however, their docking behavior follows the standard docking
behavior for toolboxes:

e Key-in window

e View Groups window
e AccuDraw window

e Drawing Scale window
e Snap Mode button bar

2.1-4j Dialogs that are Docked by Default
When you start MicroStation for the first time and open a file, certain dockable dialogs are already
docked. This is because the product delivers a docking preference file that defines which dialogs are
docked by default, and where they are located. As you make changes to the location of docked dialogs,
that information is saved in your personal docking preference file, rather than in the delivered default
docking preference file.

2.1-5 The Backstage View (File Menu)
The CONNECT edition of MicroStation platform products contains a “Backstage View” when the File tab
is clicked.

E‘J OpenRoads Modeling v L—_l I-._;;; fg f = = pwi\\dotwise.indot.in.gov:DOTWise\Docurnents!_Testing' 0l

Home Terrain Geometry Site Layout Corridors Model Detailing Drawing Production Drawing View

= ey < Import/Export ~ i 7 - 4 Offsets and Tapers ~
@ N % ¥ /S 0 %

o Design Elements = A Reverse Curves ~

Explorer Attach i Element ... ) Civil Reports  Lines Arcs  Point |
Tools = Selection i * ' Standards * Toggles - = = = * =L Spirals ~
Primary Selection General Tools Haorizontal
File Tab

This opens the Backstage View (essentially, the File Menu). The basic functionality within the Backstage
View is like what was contained within the File menu on previous versions. Specifically note the options
on the left side of the view.
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Backstage View

The remainder of this section will give a brief synopsis of the functionality contained within the
Backstage View.

e New: Creates a new file either within ProjectWise or on your local PC.
e Open: Opens an existing file. A Browse button is provided at the bottom of the Open dialog to

aid in browsing to the file you wish to open.

e Save: Saves the file.

e Save As: Saves the existing file to a different name and/or location.

e Update Server Copy: Updates the copy of the file on the ProjectWise server.

e Save Settings: Saves the active view settings in the file for when you open it again in the future.
e Send Mail: Opens Outlook with a new e-mail that has the current file attached, so that it can be

sent via e-mail.
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e Close: Closes the file.

e Tools: Provides some advanced tools to manipulate files. Of note are the Compress File and
Compress Options tools to compress the current file’s size, and the Batch Process tool to create
and run a script to run processes on a group of files.

: pw:\idotwise.indet.in.gov:DOTWise\Documents\_Testingy00013504 Design'InReads\Old Testing Data\test\INDOT_US_SVFT_3Dseed.dgn [3D - V& DGN] - OpenRoads Designer CONMNECT Editic

New

Open

Compress File Compress the design file size and remave unused element types

Save

Save As Eﬁ Compress Options Compress the design file with options

Update Server Copy

Save Settings ﬁ File Associate Assaciate file types with their proper extension

Send Mail

Close [ Peckager Create a WorkSet package with design files, references and workspace files

Tools

. Protection Set passwards or other security features on the design file

Settings.

Properties

License Management Manage and checkout Bentley product licenses that are under concurrent license control of the Subscription Entitlement Service to werkstations, laptaps, and portables

.,5 Batch Converter Convert individual files, or entire directories of files, from any of the MicroStation DGN file formats to any other supported format

@ Batch Process Create and run a script on individual files or entire directories of files

Help

N
Feedback <[> HTML Author Create HTML files from Cell Libraries, Design File Saved Views or Design File Snapshots

Tools Dialog




e Settings: Allows you to adjust MicroStation platform settings at the user level, the system (PC)
level, and the file level. You can also set up configuration variables if desired.

o User: These are settings that can be configured on an individual user level and would
apply each time the user accesses a MicroStation platform-associated file within the

managed workspace.

pwi\idotwise.indot.in.gov: DOTWisetDocuments'_Testing\0001350\DesigntinRoads'Old Testing Data\test\INDOT_US_SVFT_3Dseed.dgn [3D - V& DGN] - OpenRoa

Settings

o
¢lo System (PC)

:(:3- File

g
¢ro Configuration

New

Open

Save

Save As

Update Server Copy

Save Settings

Send Mail

Close

Tools

Settings.

Properties

Export

Publish i-model

Help

Feedback

User Settings

‘E{% AccuDraw Settings

&‘é: Button Assignments

\;@ Customize Ribbon

(—N
Q Explorer Settings

|i°@‘ Function Keys

£\
£ Gesture Assignments
ke .

% Keyboard Shortcuts

Message Center Settings

% Preferences

= ToolBoxes

Change settings for the operation and performance of AccuDraw

Assign key-ins and add key combinations to keyboard logical buttons

Customize the Ribbon and Quick Access Toolbar

Change settings for browsing and managing the content within the file and linked data

Assign key-ins and add key combinations to keyboard function buttons

Assign key-ins to gestures for touch-enabled devices

Assign key-ins to be executed when pressing keyboard keys while in the Home position

Change settings for the display of messages in the Message Center window

Change preferences and settings related to how the product operates

Open the Task Navigation user interface

Open, close and customize tool boxes

Settings > User Dialog

o System (PC): This only contains one setting (Digitizing), which is not applicable for use in

our managed workspace.




o File: These are settings that are configured and only applicable to the current design

file.

Save As
Update Server Copy
Save Settings

Send Mail

DOTWise\Documents\ ] Testing OT_US_SVFT_3Dseed.dgn [3D - V& DGN] -

f‘@’, 3D and B-spline. Change specific attributes of B-splines and 3D elements placed in the design

Color Books Create and maintain color books

-

{0 3 Configuration

., Design File Settings Change design file-specific settings
| ggDesio o 'ge design file-sp o
{5y LineSte Settings Browse and activate line styles and set line style modifiers

- Line Stye Editor Define and modify line styles

Settings > File Dialog

o Configuration: Allows you to adjust various configuration settings within the
MicroStation platform. Of note is the Configuration Variables option, which allows you

to set up configuration variables.

Settings

New
\_-"""I
Open -’:_(( } User

Save

Save As

Update Server Copy
Save Settings

Send Mail

Close

\_“1
{0 3 System (PC)

pw:\dotwise.indot.in.gov:DOTWise\Documents'_Testing\ 00013500\ Design\InRoads\Old Testing Data\test\INDOT_US_SVFT_3Dseed.dgn [3D - VB L

Configuration Settings

(x@{ Configuration Variables Edit, define, save and delete configuration variables

“I._ Configuration Migration Migrate V8i Configuration to Connect Edition

G Customize Add and manage custom tools, tasks and menus

(B@ About Configuration Display infarmation about the active configuration and its components

Settings > Configuration Dialog

e Properties: Takes you out of the Backstage View (back into the design file) and opens the

Properties dialog to display the properties of the file.
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e Print: Provides you with various options and settings relating to printing files. Of note is the
Print Organizer functionality, which is discussed in detail in Chapter 4.

: pu\dotwise.indot.in.gov:DOTWise\Documents\_Testing\0001

New

Open
Printto 3 printer or to 3 file

Save
Save As Open the resizable print preview window
Update Server Copy

Save Settings | Print to PDF Print to 3 PDF document

Send Mail

-

G Print Styles Create, edit, and delete print styles

Tools

22 print Organizer Print multiple files using Print Organizer
Settings -

Print Dialog

e Import: Provides you with several options to import file data via various file types.

ument: 50 Testing _US_SVFT_3Dseed.dgn [3D - V8 DGN] - OpenRoads Designer CONNECT Ed

Import File Data

_ DWG (cwg) Autodesk() Drawing Fie.

| ¢ Exchange File Types

New

Open

Save
Save As [@ 3D Modeling File Types L/ DBGN (*dgn) Design File. A CAD file format supported by Bentley Systems Inc. The native format file for OpenRoads Designer.
Update Server Copy
Save Settings L/ Cell Library " cel) A DGN-based file that stores cells
Send Mail

Close DGNLIB (*dgnlis) Design Library. A DGN-based file that contains dats resurces, such as cells, levels, and styles.

Tools p—
Redline {".rdi) A DGN-based file that used by for markup and redlining worklows.
Settings

Properties p—
Sheet (~9 4 3D DGN-based file in which views of the model file(s), including visible edges and sections, are attached

\_/ DgnDB (*.idgndb) DgnDB file.

Publish i-model Imodel (*imodel) A DGN-Based file that is a digital container for the open exchange of infrastructure information.

Help

s Shapefile ("shp) A popular geospatial vector data format for geographic information system software.
Text (bet) Text File. An ASCII format file that s structured as a sequence of lines of text.
Image Common raster file format.

MIE/MID (.mif) Mapinfo interchange format file stores both geometry and attributes (data) for features.

TAB ("tab) Mapinfo native format file stores bath geometry and attributes (data) for features.
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e Export: Provides you with several options to export your file data to various file types.

pw:A\dotwise.indot.in.gov:DOTWise\Documents\_Testing\0001350\Design\InRoads\Old Testing Data\test\INDOT_US_SVFT_3Dseed.dgn [3D - V8 DGN] - OpenRoads Designer CONNECT Edi

New Export File Data

Open Y
_ A DGN-based file containing a 2D design model using the content from the current model.

| Exchange file Types

Save

Save As j 3D Modeling File Types | DWG (".dwg) Autodesk(r) Drawing File.

Wbz Gy | Visualization file Types

Save Settings | Design Library (*.dgnlit) A DGN-based file that is labelled as a "Design library" that contains data reseurces, such as cells, levels, and styles.|

Send Mail

Close. | Rediine (~ra) A DGN-based file that used by for markup and redlining warkflows.

Tools

| V8 Format Design (dgn) | Bentley V8 format design file.
Settings. f—
Properties

| V7 Format Design (dgn) | Bentley V7 (legacy} format design file.

Print

Import | Visible Edges (*hin) A DGN-based file that contains the edges of surfaces that are visible

Export

Export Dialog

e Publish i-model: Allows you to convert a design file into an I.DGN file and package a set of such
files. This i-model functionality is currently not applicable to our workspace but may be
implemented in the future.

e Help: Provides various help resources to guide you with using the platform application.

e Feedback: Allows you to provide either positive or negative feedback to Bentley pertaining to
the currently active product.

e Exit: Exits the application.




2.1-6 Project Explorer — Links
The Links tab provides you with several external links to web sites to assist you with working with the
MicroStation Platform and other INDOT-CAD Resources for OpenRoads Designer. Of note are the links
listed under Bentley LEARN and INDOT.

E Links rS
€} |- @ L P

4 B Bentley LEARN
> MicroStation
4 |7 OpenRoads Designer
@ OpenRoads Designer for Existing v&i SEL
€ survey
¢ Roadway Design & Medeling - Fundam:
¢ Roadway Design & Medeling - Intermec
€ Temain Modeling
@ Geometry
@ Corridor Modeling
€ Model Detailing
G Drawing Production
G Subsurface Utilities (Drainage & Utilities
€ Review and Evaluation Courses
€ Best Practices
€ Feature Videos

- - - - 4

B Other Applications
4 B INDOT
4 Civil Cell Videos
> Documentation
4 |7 INDOT Info
@ Map Insert
€ INDOT Helpdesk Information
4 7 IN.gov
G Home
@ CAD Support
@ Design Manual

¢ Design Information =

Links Tab

NOTE: The Links tab is not enabled for display by default. To have it displayed, you will need to go into
the File menu (Backstage View) per the following instructions:

1. With afile open in the MicroStation Platform, click on the File tab to access the Backstage View.




Geometry Site Layout Corridors Model Detailing Drawing Production Drawing View

* = | = Create Civil Cell =\ ﬁ & 75 Create Conic Slope
' D

#- Process Civil Cell = Create Transverse Align...

Element - Place - Apply Apply 3
Selection t4 7 | Civil Cell 2 Drop Civil Cell Linearll:!emplate Surface %mplate Elements* = Create Transverse Tunnel

Primary Selection Civil Cells 3D Tools Technical Preview

File Tab

2. Inthe Backstage View, click on Settings > Explorer Settings.
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Settings User Settings

*E% AccuDraw Settings Change settings for the operation and performance of AccuDraw

\_F"’"I
i ic.‘} System (PC)

g} -
Save As HE } File e:‘ﬁ Button Assignments Assign key-ins and add key combinations to keyboard logical buttons

. - g !
Update Server Copy i § Configuration

Save Settings I_ﬁ Customize Ribbon Customize the Ribbon and Quick Access Toalbar

Send Mail

Close '{Q Explorer Settings Change settings for browsing and managing the content within the file and linked data

Tools

F?& Function Keys Assign key-ins and add key combinations to keyboard function buttons
Settings —

Properties ==
‘Eﬁ Gesture Assignments Assign key-ins to gestures for touch-enabled devices

Explorer Settings

3. Inthe Explorer Settings dialog, locate the Links section and change the Visible setting to Yes.
Click OK when done. The Links tab will now be displayed in Project Explorer.
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File ~ o~

Visible No

Display

Items -~
Visible Yes

Group by Label Yes

Group by Relationship Type No

Group by Related ltem Type No

Resources -~
Visible No

OpenRoads Model ~
Visible Yes
Sheet Index -~
Visible Yes

Links ~
Visible Yes

Indexing Service Stopped

OpenRoads Standards ~
Visible Yes

Drainage and Utilities Model -~
Visible Yes

R a v

Cancel

Visible Setting for Links Tab

2.1-7 INDOT_WS Workset and Sheet Indexing
As previously mentioned, all projects created after the release of the INDOTWise 5.1 Workspace will
automatically have an INDOT_WS workset defined for the project and users will be able to now start
using sheet indexing in the 2023 versions of MicroStation/OpenRoads Designer. This section will give a
brief overview of sheet indexing and how to manually add/remove sheets. Further discussion can be
found in the INDOTWise 5.1 ORD Plans Production document as it pertains to cutting various sheet
types, and then in the INDOTWise 5.1 Plotting document for discussion on how to use a Sheet Index to
generate a plot set.

2.1-7a The Sheet Index Interface
The Sheet Index is provided as part of having an active Workset in a project. It allows for the user to add
sheets to the Index for quick access to various sheets, sheet categorization, and to send to a plot set. In
this initial release, sheet index settings are being driven by the application defaults and can be adjusted
upon user request for our templates moving forward.

The Sheet Index interface is available to all users of a project; however, it should be noted that only one
user can access the Sheet Index in an editable fashion at a given time. This is due to the nature of the
ProjectWise check in/check out process and restrictions it places on file access.

The Sheet Index can be found as an entry on the Project Explorer and has the following commands on it:
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Explorer b 31X
bl File

W Items

E(J Resources

| OpenRoads Model

> (¢|(¢ ¢ ¢

.2 sSheet Index
QH=/Q9f.

b s INDOT WS (1)

Sheet Index (Read Only)

7 Sheet Index A

b i INDOT WS (1)

Sheet Index (Read-Write)

As shown in the previous screen captures, there are two states to the Sheet Index interface. The Read
Only version is typically what is presented when opening a file in its default state. This version presents
the following tools (From L to R):

Refresh — Refreshes the sheet index.

Place sheet index as a table — Not currently customized, can be used with default settings.

Open Print Organizer — Opens Print Organizer with all sheets in the index automatically added to
the set. This is discussed further in the INDOTWise 5.1 Plotting document.

Open Sheet Index for Edit — Makes the sheet index editable to add sheets, adjust settings, etc.
Transparent — No function on this panel.

Zoom — No function on this panel.

Isolate — No function on this panel.

When the Open Sheet Index for Edit button is selected, the workset file will be checked out, and the
following commands will be shown in the Read-Write format (From L to R):

Refresh — Refreshes the sheet index.

Place sheet index as a table — Not currently customized, can be used with default settings.
Open Print Organizer — Opens Prin Organizer with all sheets in the index automatically added to
the set. Thisis discussed further in the INDOTWise 5.1 Plotting document.



Make Sheet Index Read Only — This replaces the Open Sheet Index button, and when selected
will check the Sheet Index workset file back into ProjectWise.

Add Sheet/Folder — Used to add sheets to the index. If add folder is selected, additional folders
can be added to the index for file classification.

Manage Sheet Index — Allows for the customization of the sheet index configuration, such as
sheet prefixes/suffixes, automatic numbering and incrementing, etc.

Update All Sheet Properties — Updates any document properties that pull from workset values.
Not necessarily applicable in our current ProjectWise environment as we facilitate sheet
numbering and other document properties through either the design script or ProjectWise
interface properties.

Show Modified — Any sheets with differences from the workset values will be highlighted in
blue. Not currently applicable in our ProjectWise environment as workset properties are not
being used to populate file content.

Delete — Only available if a Document/Folder in the index is selected. Removes the selected
entry from the index.

Transparent — No function on this panel.

Zoom — No function on this panel.

Isolate — No function on this panel.

In the following sections, we will cover some of these commands and their potential usage in our
workflow. Please consider this a starting point for the functionality of the toolset and reach out to your
CAD Peer Group members with suggestions for consideration.

2.1-7b Opening the Sheet Index for Editing

As already noted, an INDOT_WS workset and sheet index will be provided by the project creator for all
INDOTWise 5.1 Workspace projects. To open this file for customization and editing, simply enter a CAD
file in the project, and in the Project Explorer, and select the Sheet Index entry. On the Sheet Index
toolbar, then select the Open Sheet Index for Editing button:
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Open Sheet Index for Editing

When selected, a brief check out dialog will appear as the index/workset file is checked out. The toolbar
will then switch from the Read Only version to the Read-Write version shown previously.




2.1-7c Sheet Index Customization
At this point, customization of the index can be performed, and the settings shown below (accessed via
the Manage Sheet Index tool) can be modified. Suggestions for default configurations will be
appreciated as this is further implemented. For this example, the following default settings will be used:

ﬂ Manage Sheet Index x
Index Sheet Numbering Controls ~
Folder Automatic Naming of Sheet  On
Shest Increment 1 X

Inherit Naming Rule From Parer Off

Mumber of Digits 3

Sheet Number Prefix A

Sheet Number Suffix

Show Leading Zero On

Start Number 1

Total Shests Count 0

Manage Sheet Index

2.1-7d Adding Folders/Sheets
With the index in Read-Write mode, users can also add folders and sheets directly to the index. In this
example, sample folders will be created and files containing sheets will be added.

Note: OpenRoads cut sheets can be directly added to the sheet index by enabling the Add to Sheet Index
setting on the respective Named Boundary tools. Discussion of this method will be covered in the
INDOTWise 5.1 ORD Plans Production documentation.

For the first example, a few new categorization folders will be added to the sheet index for different
sheet types. With INDOT_WS selected, pick the Add > New Folder button and add a folder:

@ Sheet Index 3

QO HRE R+ 8L IX[QL
[ Add Sheet
4 Mew Folder

Add a New Folder
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[ Mon-0ORD Sheets

Sample Folders Created

Note that these folders can be re-arranged in any manner simply by dragging and dropping them with
the Sheet Index in Read-Write mode. This allows for the index to be configured with the sheets in the
order they would potentially be accessed or for plotting purposes.

Note: The following method to add sheets via the Sheet Index > Add Sheet has a bug in OpenRoads
Designer 2023 which has been acknowledged by Bentley. Attempting to add sheets via this method will
result in the following error.

&4 Information >

@ --<ERROR_WorkSetMismatchs --

Adding Sheets Error

Please review the alternate drag and drop method at the end of this section. The following information
is being preserved for use in later versions where this bug has been resolved.

With these folders created, sheets can now be added. The following example will show adding sheets
that were previously cut in OpenRoads Designer, but not added directly to the index. In this instance,

Plan Profiles will be added. To start, the Plan Profile folder will be selected, followed by the Add > Add
Sheet button:




@ Sheet Index ﬁ

QHE R+-0 VA X QL.
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[F Mew Folder

Cross Sections

Mon CRD Sheets

Add Sheet

In the presented ProjectWise dialog, navigate to the file(s) to add. When completed, the dialog will
proceed to add any sheets in the files selected to the selected folder in the index.

9 Sheet Index F
ORB@+-0RDAIX RS
4 2 INDOT_WS (3)
P Plan Profiles (3)
[ A0D1 [1, 1] Line A - Plan 1 [Sheet]
(3 A0D2 [2, 2] Line A - Plan 2 [Sheet]
(3 A0D3 [3, 3] Line A - Plan 3 [Sheet]

[ Cross Sections

Mon ORD Sheets

Sheets Added to Index

With the files in the index, users can then navigate to them directly through this interface.

In addition to the preceding process, users may also drag and drop sheet models directly from the
Models dialog into the sheet index to add them. To complete this method, enter the DGN that contains
the models you’d like to add. Select the appropriate models on the models dialog and drag and drop
them onto the sheet index. While processing, a brief progress dialog will display the progress of the
process. Note that this process will need to be completed for each DGN containing sheet models in the
project.
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Drag and Drop into Index

When complete, the index will reflect the new sheets added.
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Sheets Added via Drag and Drop

With folders and sheets added, the order can then be manipulated simply by dragging and dropping the
sheets/folders in the desired order. Setting this order is important, as it will determine the inital sheet
order and organization if the sheet index is used at the basis for a Print Organizer set.



2.1-7e Closing the Sheet Index
At this time, the Sheet Index should be closed to editing by selecting the Make Sheet Index Read Only
button, and when prompted, checked back into ProjectWise.

@ Sheet Index

O HEe .bg o,
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(8 A001 [1, 1] Line A - Plan 1 [Sheet]
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[ Cross Sections
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Make Sheet Index Read Only

2.2 User Interface Enhancements

The addition of drag-and-drop support, the ability to customize right-click menus and the Tasks dialog,
and three new ways to customize the status bar make the interface easier to use.




2.2-1 Drag-and-drop Support
All current MicroStation Platforms contain the ability to drag and drop across several different
application areas. The following covers these areas.

Note: Not all functionalities will be available when working within ProjectWise.

¥ |
Reference Dialog Project Explorer Models Dialog
a
™ Attach Reference o rt Model
Model Link ) FEPPREES "
2 Any Link
g
Batch Processor o
B Saved View Link
=
™ Add Batch Job 2| 2
&
™
o (I

I

ol
Ll
-

View Window
Windows Explorer
|
Files _ | Attach Reference
y
] CTRL Key
Folders Saved Views Dialog # Place Call
DGN Files —— ALTKey ! Link on Element
DWG Files — Import Saved View ALTKey ! Link on Element
DGNLib T p{ Attach Reference
ALTKey Wl |ink on Element

MicroStation Native Drag and Drop Operations
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Some of the possible drag and drop operations are:

e Drag and drop models from the Models dialog to the Project Explorer dialog

e Dragand drop a saved view from the Saved Views dialog to the Project Explorer dialog

e Drag and drop files and folders from Windows Explorer to the Project Explorer dialog

e Drag and drop links from the Project Explorer dialog to a view window

e Dragand drop links within the Project Explorer dialog

e Dragand drop saved views from the Saved Views dialog to a view window

e Dragand drop models from the Models dialog to a view window

e Drag and drop DGN, DWG, and DGNLIB files from Windows Explorer to the Saved Views dialog

One common use of the drag and drop feature is between the Models dialog and a view window.

Models Dialog

View Window

Attach Reference

CTRLKey | piace Cell

ALT Key

pl Link on Element

Drag and Drop Functions with Command Modifiers



2.2-2 Show/Hide Support in Status Bar
Right-clicking in the status bar opens a menu allowing you to show or hide sections of the status bar.

Snap Mode
Locks

Active Level

SIS SN

Selection Set

Tasks

Running Coordinates
Fence Mode

Work Mode

File Changed

Design History
Dialog with Focus
RS5 Message Notification
Project

File Protection

Cached Visible Edges Status

SR8 R SIS 88 S S

Show All
List...

Status Bar Options

2.2-3 Coordinates Display in Status Bar
Left clicking in the Running Coordinates section of the status bar turns on the coordinates display. As
you move your cursor, the coordinates of your current position display according to the active Tentative
Point Mode. When you left click, a menu displays six options. The Delta modes show the X, Y, and Z
displacement from the last data point. The Distance modes show the distance and direction from the
last data point.

v Position
Delta
View Delta
Distance
ALCS Position
ACS Delta

Coordinate Formats



2.2-4 Locks Dialog
Left-clicking the Locks icon on the Status Bar and then clicking on the expand arrow on the bottom right
corner of the popup menu opens the Locks dialog.

«d

[] ACSPlane Annotation Scale
[ Grid Lock [ Graphic Group
Level Lock

Fence Mode: | Void-Clip A
Snap
: Snap Lock
Mode: | Keypoint A
Diviser | 1
Association Lock
ACS Plane
Axis
[ Axis Lock

Start Angle: | 00°00'00"
Increment: | 90°00'00"
Unit
] Unit Lock
Distance: | 0.1312

Isometric
[ Isometric Lock

Isametric Plane: | Top hd [roevereona)

Annctation Gri

Scale Lock

ul

Locks

& | s_SURF_Top of bz

Locks Dialog and Menu



2.2-5 Tool Boxes
With the ribbon interface in the CONNECT version of the MicroStation Platform, toolboxes aren’t as
prominent as they were in the V8i version. However, there are still a number of these tools that users
may wish to have quickly accessible in all situations regardless of the Workflow on the ribbon. The
following discussion will cover how to locate these Tool Boxes, enable them, and make them a direct
part of the user interface.

Tool Boxes can be found two different ways in the MicroStation interface. The first is through the
Backstage area, located under the File menu.

kd Drawing ~@- odkle = pw:)

View

Annotate Attach Analyze Curves Constraints U

= =
Default - Q E
CIR:E

— . . + | Exnpl Attach
=0 @0 0 s Tools = F@*'@'

Properties * 0 X | Explorer *h 31X
4 Maodels (1) bel File v
4 l':.]'_1 Default W Items w

B E| Alignment.dgn,Default Ej Resources v

Use the File Ribbon to Enter the Backstage

In the Backstage, select the Settings on the left, and then under the displayed Settings, select User. On
the right column under User Settings, select the Tool Boxes entry toward the bottom of the display:




Settings User Settings

[ ACET R ————

@

oot | ot e s s e s T
‘ - ~

Tool Boxes Backstage Location

Alternatively, one can use the Search Ribbon in the upper right corner of the interface to search for Tool
Boxes and enter the Tool Box selection directly:

1

CYON SR

| Ribban (1) A

29\ Corridor.dgn [2D - V8 DGN] - OpenRo tool box| £3

|
1:| Backstage (1)
n
ol =3 Tool Boxes

WES

Show Details

Tool Boxes via Ribbon Search

Both options will open the Tool Boxes dialog where the various tools can be enabled.
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l

[ 2D Constraint Tools
[ 2D View Control

[ 3D Constraint Tools
[ 3D Geometry Tools
[ 3D View Control
[ 3d Input

[ acs

[ AccuDraw

~ Tool Boxes <

[ Large Buttons
Show Tool Tips
Immediately Open

Customize

[ Angular Dimensions

[ Animation

[ Animation Actors

[ Animation Cameras

[ Animation Settings

[ Annotate

[0 Applications-Custom

[ Arc Between Elements-Custom
[ Arc From Element-Custom

[ Arc To Element-Custom

[ Ares

[ Attach Element

[ Attributes

[ AuteTURN 3D-Custom v

Cancel

Tool Boxes

Some that may be of interest:

e Drawing Scale — Quick access to the Drawing Scale and working unit tools. Found in multiple
locations via the various workflows, these tools are accessed frequently enough to consider
having docked at all times.

e Geographic — Tools related to application and usage of Geocoordinate Systems. Another
frequently used tool set that is advantageous to having available at all times.

e AutoTurn-Custom — For users that frequently use AutoTurn, these are the same tools that get
placed in the Drawing > AutoTurn ribbon when activated. This tool box is available at all times,
but please note that the tools will not function unless AutoTurn is started from the INDOT Tools
workflow.

2.2-6 User Preference Changes
With the release of the INDOTWise 5.1 Workspace, INDOT CAD Support has moved the location of
MicroStation platform preferences to a new location that should be much more user friendly and make
backing up and restoring user preferences much easier. This discussion will cover this location and in
what situations a user might want to interact with the contents of the folder.

Moving forward with the 2023 MicroStation Platform/OpenRoads Designer 2023, CAD Support has
migrated the User Preference path to C:\Users\<username>\INDOT ORD Preferences. <username>
should be replaced with the username of the active user. It should also be noted that the user
preferences are now tagged as “INDOT_<username>_ORD....."” to easily identify that these are specific to
the INDOT Workspace.

An example of how this looks can be found below:
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With this path, users can perform the following self-service maintenance operations.

e Backup of User Preferences — Users can copy this folder and its contents to another location
once they’ve configured their application interface (tool locations, docking location preferences,
tool boxes enabled, etc.) to have a clean copy of their preferred settings.

e Restoration of User Preferences — If users have made a copy of their preferences as previously
mentioned, they can place the contents back in this location to quickly restore their preferred

default preferences.

e One of the first troubleshooting steps that is performed is often to delete user preferences that
have seemingly been corrupted. With this location now accessible, users may delete their own
preferences as an initial troubleshooting step. When performing this operation, all content in
the folder should be deleted. As recommended earlier, users can then restore a known good
backup of their preferences to have the preferred setup restored.



2.3 Models Enhancements

The enhancements to Models include additional viewing capabilities, Project Explorer integration with
the Models dialog, and sheet name display in the Models dialog.

2.3-1 View Different Models from the Same File in Each View
You can view more than one model from the same file in separate views. In the example below, notice

that the “Multi-models View” view was created and the titles of the two views match two separate
models in the Models dialog.
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[51| & |p_Rowy_paved Ditch 817199.1521, 409691.8953, 547.9610 |

2

Multiple Model Display

To view different models in each view, first start by opening an additional view from the Manage View

Groups toolbar. For this example, open view 2. Alternatively, you can also open it from the View ribbon
in most workflows.
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Manage View Groups

In view 2, select the View Attributes in the upper left corner of the window. Locate the View Setup

controls in the bottom portion of the dialog:

B View 2, Des Alignment

View Number:

@ Presentation

Display Style: |0 Wireframe
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Nan'e:l Presentation He\ght Field

*%2 Placement Point

Global Brightness: ’
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Models Des Alignment ~

View Attributes and View Setup

In the View Setup portion of the dialog, you may select either an existing saved view, or one of the
available models in the file. Doing so will make it display in the view separate from the primary view

that was displayed.
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Selecting a Saved View or Model

With multiple models displayed in this fashion, the Manage View Groups dialog will now display Multi-
Model Views as the active view. Note that this can be saved, and alternative views can be configured
for use.

&)~ . - & - D Mutti-Model Views ~ E:l||3|4|5|5|?|s‘

Note: For the OpenRoads Designer environment, there is a provided series of commands in the View
Control context menu that will be discussed in that module. In this environment, it facilitates similar
functionality with additional enhancements for the civil environment.

2.4 Text Enhancements

Text enhancements include the ability to change case by a selection set or fence. The Advanced tab
allows for comparisons between styles. Word Processor updates include an insert field, subscript and
superscript icons and right-click operation to change the case. The Edit Text tool retains its text settings,
and the Find/Replace Text tool supports data fields.

2.4-1 Change Case by Selection Set or Fence
This tool is used to change the case of a piece of text. Case change options include Upper Case, Lower
Case, Title Case, and First Capital. This tool also supports text selection via a fence. This tool can be
found in most workflows on the Text Group in the Drawing Production tab. Click on the dropdown
arrow in the Group, and then select the Change Case tool.
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2.4-2Advanced Tab in Text Styles Dialog Allows Comparison Between Styles
Two new modes (Comparison and Differences) have been added to the Advanced tab of the Text Styles
dialog. Comparison mode shows a side-by-side comparison of the properties of two selected text styles.
Differences mode shows the differences of the properties of two selected text styles.
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2.4-3 Text Editor Enhancements
Three new icons have been added to the Text Editor dialog.

The Insert Field icon opens the new Field Type Picker dialog, used to select the type of field to be
created. See Placeholder fields for more information.

[t}

Text Functions
The Superscript icon allows you to create text with superscript by typing in the text, clicking the

superscript icon, then typing in the number. The Apply Changes to all Text check box must be toggled off
to place superscript.

P

Superscript Text

The Subscript icon allows you to create text with subscript by typing in the text, clicking the subscript

icon, then typing in the number. The Apply Changes to all Text check box must be toggled off to place
subscript.
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2,

Subscript Text

2.4-3a Right-click to Change Case
The Change Case menu items (All Upper, All Lower, Title, and First Capital) have been added to the right-
click menu of the Text Editor dialog.

2.4-4 Using Fonts
MicroStation supports three types of fonts: True Type, RSC (MicroStation Resource Font) and SHX
(AutoCAD Fonts).

2.4-4a True Type Fonts
Many TrueType fonts are delivered with Windows, and many more are available from various vendors
for free or for purchase. TrueType is an industry standard format supported by MicroStation. In general,
this is the recommended font type for use in MicroStation. TrueType fonts also include full Unicode
support (note: not all TrueType fonts contain characters for all languages). TrueType fonts are always
filled, and therefore do not provide good support for “stick” fonts (as opposed to SHX and RSC fonts).

2.4-4b RSC (MicroStation Resource Font)
This font format is MicroStation-specific, and RSC fonts are stored in MicroStation resource (.rsc) files. A
single resource file may contain several RSC fonts. RSC fonts have a number and a name, but only one
font by a given number can be used at a time during a MicroStation session. If multiple RSC fonts share
the same number, the last one to be loaded is the font assigned to that number in each session. RSC
fonts are locale-encoded, but support more than 255 characters (e.g., for some Asian languages). The
code page of RSC fonts is specified in the font configuration file. If you use font characters for symbols,
use RSC fonts rather than TrueType fonts.

Due to various compatibility issues, and lack of customization tools, RSC fonts other than those provided
with SignCAD, or the MicroStation Platform are no longer available for use in the INDOT Workspace.

2.4-4c SHX (AutoCAD Fonts)
MicroStation supports AutoCAD’s font format (including normal SHX fonts, SHX Unifonts, and SHX
Bigfonts). You should use SHX fonts only when you must ensure AutoCAD compatibility, and TrueType
fonts are not a viable option. SHX Unifonts are the current standard and allow a single font (and font
file) to contain characters in the entire Unicode range. Older SHX fonts only support up to 255
characters, and thus require a paired SHX Bigfont to support languages with more than 255 characters
(e.g., Asian languages). In MicroStation, specifying a paired SHX Bigfont is optional, and is recommended
if you require characters that cannot be provided by the base SHX font.

If AutoCAD is installed, MicroStation searches for SHX fonts in AutoCAD’s Fonts directory (the “Fonts”
folder in the installation directory of the most recently used version of AutoCAD). With or without
AutoCAD, MicroStation searches the directories specified by MS_FONTPATH, as well as the same
directory as the design file requesting the font.
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DWG Export: AutoCAD natively supports SHX fonts, and no special export is performed.

2.4-5 Edit Text Tool Retains Text Settings
In the past, the Edit Text tool would change the active settings whenever you edited a piece of text. This
behavior has been changed so settings revert to the previous settings when the Edit Text tool is closed.
This change affects the active settings only and not the text styles.
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2.4-6 Disabling Text Field Backgrounds
Various text tools may take advantage of MicroStation fields, tying Model or other properties to a piece
of text. Depending on the workflow, it may be desirable to disable the background of the text field for

use in other applications.

Starting with MicroStation 2023, the text field background has been moved to the View Attributes for
each model. Under the View Attributes locate and disable the Text Field background shown below. This
is a per model setting and has been set for INDOT Sheet Seeds used with OpenRoads Designer.

B View 1, Default [Displayset]
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Text Field background

2.4-7 Special Character Symbols
The MicroStation Platform has included a true type font style—Engineering Vert—that includes the
various special character symbols you use to insert in your drawings. The advantage of this is that you
no longer need to search through a cell library to find the proper cell that contains the symbol you
need—it can just be placed directly via the Text Editor. Simply open the Text Editor and click on the

Insert Symbol button.

Style (none)

A ————)
M ',\;- - f(5) | T Tahoma “|atjoo2 I+ B I U L, (P =I~

Z---l---l---l-

Insert Symbol Button



Then on the Symbol Inserter dialog that appears, go to the All Symbols tab and select the Engineering
Vert font. With the symbols for the font listed, scroll most of the way down the list and you will find the
various symbols you might need (flowline, property line, centerline, etc.).

4 A
Style (none) . jf T}C @ * o0 v fix) | T Tahoma
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BiMRGE

Favorite Symbols | All Symbols

' Engineering Vert -

'.ar .N.a Nq— 3

3 Kk oy Lt & °
o |owP|p|PpQaq P bbb
AN AN 4t Nn|6 gk
kiNARIF Ss | H" = wd 9|
LY I BUSL AUSLN S
T Vi G B P A D O P P A
sl Hm RS le (B |©D |,

a Unicode Name: U+F40F
Escape Code: 62479

Engineering Vert Special Character Symbols

Starting with the INDOTWise 5.1 workspace, these symbols are now also being preconfigured as
favorites for all workspace users and can be located directly under the Favorite Symbols dropdown.

A Text Editor

Style (none) - P aly @]~ 9| T Al | atloooz2 [ ]~ B
e e e — —— Favorite Symbols | All Symbols

Degree

Center Line Symbol

Flow Line Symbal

Property Line Symbol

+ Font: T Arial
Code Point: 0x00B1

Favorite Symbols

Note that the preceding process can be used for a variety of symbols and across several fonts. Not all
fonts will contain the same symbols, nor will they necessarily be in the same locations.



2.4-7a Using Special Character Symbols in Conjunction with INDOT Text Styles
In most cases, you will want to place a special character symbol in a line/block of text that has an INDOT
Text Style associated with it. Considering that the font used for special character symbols (Engineering
Vert) is different from any of the fonts configured with our INDOT Text Styles, this can create a potential
conflict. If you apply an INDOT Text Style to a special character symbol in an existing line/block of text, it
will turn into a box icon, as shown in the example below:

JI o, T T W | e | e p— | = JI o Oy e W0 | e e |
A A
Style (none) 1y v 10 Point Text 1y
x ' L T B T >__< L S T D R |

Special Character Symbol Before and After Applying an INDOT Text Style

The process to work around this issue is to apply the text style FIRST and then place the symbol within
the text as specified in the previous section.

1 s T, T T | e BT | p—— | e T

A

7 12 Point Text R D T ) v v v A9 T Engineering Vet~ | AT|00100 [
S S S N S SN B SN
Sample Text Here: @

Sample Text Here: @

Enter Text

Special Character Symbol Placed After Applying an INDOT Text Style

It should be noted that the size of the symbol that you place will automatically match the font size of the
selected Text Style.



2.5 References Enhancements

A major enhancement to references is the ability to edit a reference from within the active model. In
addition, the active model's annotation scale applies to annotations in references.

2.5-1 Activate Reference for In-Place Editing
The MicroStation Platform lets you edit a reference in-place. That is, you can edit a reference from
within the active model. To do this you first must activate the reference.

Export Terrain Model 2
Clear Active Terrain Model
¥ Properties

WView Control r

o3 Copy

[0 | Activate

Exchange

Open in new sessicn
Copy Reference
Move Reference

%3 Scale Reference

% Rotate Reference

4 Clip Reference

x1 Detach Reference
@

Set Reference Presentation

1Ety

Select All
Select Mone

dw i

Select Previous

Displayset Set

Cut to Clipbeoard
Copy to Clipboard
Paste from Clipboard

N S H

Turn Level Off by Element
Delete Element

b 4

Reference Activation




When a reference is activated:

e Only operations on the activated reference are permitted.

e By default, all elements in references above the activated reference in the file hierarchy, as well
as the active model, are displayed with an override color. You can control whether an override
color is used, and what the color is.

e If you activate another reference, the currently activated reference is automatically deactivated.

e The reference is locked so that it cannot be edited in another session.

e DGN library data, such as levels and level filters, is not available in an activated reference file.

e Activated referenced in InRoads allows for the interaction with underlying civil data such as
terrains and alignments.

Note: Activating references should only be used with core MicroStation Platform content. Elements with
additional information such as civil content from OpenRoads Designer, or vehicle paths from AutoTurn
should not be modified via an Activate reference. Doing so can cause the extended information these
elements contain to be corrupted or removed resulting in application crashes or lost data.

2.5-2 References Support Active Model Annotation Scale
In the past, you may have added annotations to design models that are referenced into sheets. You also
may have added annotations directly on the sheet. If the annotations were too small, you would have
changed the model's annotation scale, but that would have affected only the annotations directly on the
sheet. The annotations in the reference were not changed. Therefore, the only way you could change
the annotations was to exchange into the reference and scale them.

Now the active model's annotation scale applies to annotations in references, too. If you change the
scale of the annotations on the sheet, the scale of the annotations in the references changes as well.

To make a reference's annotations use the active model's annotation scale, you must turn on this
option. In the References dialog, there is a button along the bottom named Use Active Annotation Scale.
Use this button to toggle this setting on and off as desired.

Tools Properties

Bl- o DAY A3 7D 9 @ s HiteMode [Boundaries

Hierarchy slet 3 FileName Medel Description L
(ORD_PrPlan_July 22.dgn, Defaut| 2 ORD_PiPlan July 22.dgn Default-30 ]
[ PW_WORKDIR:d0776645\0RD_Survey Fieldbook July 22.dgn Default Master Model ]
< >
Scale [ 1000000000 1.000000000 Rotation | 00°00'00" Offset X| 0.0000 ¥[0.0000
i o & @ B = Attachments: | Ne Nesting =] Nesting Depth: [1 Display Overrides: [EllGWINT
New Level Display: | Config Variable ¥ | Georeferd Use Active Annotstion Scale

Use Active Annotation Scale



2.5-3 Detail Scale
Detail scale helps you represent the Master:Ref scale in terms of the sheet scale. For example, if your
sheet scale (annotation scale) is 1/8” = 1" and you want to place a detail reference of scale 1/4” = 1’,
simply pick the new scale from the Detail Scale combo box. It automatically computes the Master:Ref
scale as 2:1.

2.5-4 Synchronize with Saved View
When you attach a saved view, you can specify that the display of the reference should always be
synchronized with the original saved view. In the Reference Attachment Settings dialog, turn on the
Synchronize with Saved View check box.

To change the appearance of a reference, you must modify the saved view that it is synchronized with.
This is to ensure fidelity of display properties such as view attributes, level masks, clip volume, display
styles and others.

When synchronized, the reference location is also realigned. Specifically, when the reference is
synchronized with the saved view, the reference center and saved view center remain aligned. You can
see the effect of this in two ways:

In an unsynchronized state, the reference is first shifted and then synchronized.
When synchronized, the saved view center is changed; for example, the saved view is stretched.

2.5-5 Change Attachment Orientation
In this edition you can change the orientation of the reference attachment by clicking the reference's
Orientation column in the References dialog.

2.5-6 Reference Detail Scale
When attaching a reference (a design or drawing model) into a sheet model, the referenced model's
annotation scale is applied as the detail scale, and the Reference Scale (Master:Ref Scale) is calculated
from the referenced model's annotation scale and the active model's annotation scale.
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3. Imagery in MicroStation Platform — WMS and Map Insert

3.1 Introduction to WMS

A Web Map Service (WMS) is a standard protocol which provides georeferenced map images over the
Internet that have been created by a map server using data from a GIS database. At INDOT the map
data is obtained from the ArcGIS Server. The MicroStation platform can then be used to connect to the
WMS. The INDOT WMS server connections have already been established and preset WMS map
definitions (XWMS files) have been created for the available images. Currently the available map
definitions are NAIP 2008, NAIP 2010, NAIP 2012, NAIP 2014, NAIP 2016, Ortho 2005, Quad 24k,
2011_2013 Statewide Imagery, Best Available (which is a constantly updated map containing the most
recent and highest resolution imagery, currently the 2011/2013 images), and Most Recent Available
Imagery (which is the most recent imagery available but is not survey grade and will show differences in
geocoordinated data situations). These preset map definitions are in ProjectWise at the following
location: Documents\Resources\XWMS.

3.1-1 Open Existing Map Definition
NOTE: When importing any imagery files (including XWMS files, .iTIFF, .jpg, .pdf, etc.) into any
MicroStation-based application, please note that you should only do so in 2D models. DO NOT import
them into 3D models—as this will cause significant issues if any plan sheets containing imagery files
would need to be plotted.

1. Open a MicroStation based session from within ProjectWise. From the Drawing workflow,
locate the Primary Group on the Home tab, click on the dropdown next to “Attach Tools”, and
then select Raster Manager:

ﬂ 'Drawing v I'f' H l'._::g E::: ’ g] = pw:i\hdotwiseindotin.gow: DO
.. View Annotate Attach Analyze Curves Constraints Utilities Drawing A

@ [None + | Default . G@‘Explorer |_L| Reference = @ Properties
rﬂ Attach Tool;E% Level Manager * @ Mare =

20 "m0 T|EF0 /@0 &0 - .
- - = @ = |_L| References Level Display ~

Attributes

ﬁ Raster Manager Primary

Paint Clouds

Reality Mesh

Raster Manager


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CResources%5CXWMS%5C

2. Onthe Raster Manager window select File -> Attach -> WMS.

!F‘.aster anager : 0 of 0 listed

File | Ei View Display Settings
New » R - B B %
1 Attach ¥ |Eq Raster.
Detac Bg

Detach Ea From Image Server...

Reload °°"a ECWP Image Server...
Save As... % L T

ﬁ Attach Raster Grid
Export 4
Import 4

Batch Convert

Attach WMS

3. ProjectWise’s Attach Raster Reference window appears. In ProjectWise navigate to pw:\\indot-
pw.bentley.com:indot-pw-01\Documents\Resources\XWMS\. Within this folder, select the

XWMS resource file you need to attach.

] Attach Raster Reference x
Select
Documents
Fulder|[: KWMS v| & plEEA
# e ~[>
Name ~
A Docs

# ] 2005 Statewide Imageryovms
/] 2011_2013 Statewide Imagerysowms
/] Best Available Imagerywms
/] CADStreetAnnoswms

# " Most Recent Available Imageryaovms ©
< >
Application: Al applications v
Extension: [ all documents v
add Remove

Selected Documents

Name Description File Name Folder Storage  Sto

Attach Raster Reference Window

4. Once the XWMS file has been selected, select Add -> OK.
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pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CResources%5CXWMS%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CResources%5CXWMS%5C
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Selected Documents
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Select an XWMS File

5. Inthe Raster Attachment Options window adjust options as desired, and then select Attach at
the bottom of the window.

£ Raster Attachment Options — m] X
=-H
E cwsers'psmock dotwise \pw_work'd0298515\Best Available Imagery xwms
General ~ Image ~
Level Logical Name
Color Description
Line Style
‘weight
Class
Geometry ~ Color -~
Geo Priority Raster Header Tint [] [255.255,255]
Inherit GeoCS from Mod Not Inherited Contrast 0
Brightness 0
Invert Do Not Invert Display
Transparency Hide
Display Print ~ Extended -~
Views 1-2-345678
Flane Background Locked Unlocked
Print Printable
Print Gamma 1.00000
Display Gamma 1.00000
Clip Show
Draping No

Raster Attachment Options

6. The image is now attached to the DGN as shown in the Raster Manager window.




E Raster Manager: 1 of 1 listed - X
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Attached Raster Image

3.1-1a Attaching Aerial Imagery into Files with Direct 3D Reference Attachments
A “defect” has been observed in ORD 2023 when aerial imagery is attached to a file that has an existing
3D reference file (e.g., a survey fieldbook) directly attached. In this example scenario, the aerial imagery
is placed on top of the display of the referenced survey data in the file—which is undesirable behavior.
Note how the imagery is placed on top of the survey data in the example below:

Attached Aerial Imagery Concealing Survey Data

To get the survey data to display on top of the imagery as it should be, users will need to do the
following:

81 |




1.
2.

3.

Open the References dialog.
In the References dialog, go to Properties > Update Sequence.

@ References (2 of 3 unique, 2 displayed) — X
Tools | Properties
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Update 5
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Update Sequence

In the Update Sequence dialog, select your referenced 3D file (in this case the survey fieldbook)
and using the arrow buttons at the top of the dialog, put that file at the bottom of the list. Then
click OK to proceed.

& Update Sequence >
ANV Y
Slat  File Name Model Legical Mame
2 1700155_Alignment.dgn Default-2D Ref
1700135 Alignment,dan Default Active Design File

l 1 PW_WORKDIR..\1700155_Survey Fieldbook.dgn Pefault

Moving 3D Reference to Bottom of Update Sequence List

The survey data should then become displayed, as shown below:




3D Survey Data Now Displayed

3.1-2 Using Descartes to Merge Imagery
When using the available WMS imagery, there may be a need to create a copy of the streamed imagery
and have a direct image attachment to a file. This section will cover the process to use the Descartes
Merge tool to create this direct attachment and save it back to ProjectWise. Doing so will ensure that
the imagery used is always available as part of the project data.

Also, this section will cover the settings to create a reasonably sized image with appropriate resolution
and quality settings. Note: Imagery settings are largely dependent on the situation where the imagery is
being used. These settings straddle a performance/size to quality line and should work for most
situations. Please keep in mind that large project areas or deviations from these settings can possibly
result in very large image files that can negatively impact performance and downloads/uploads to the
system.




To merge and create a directly attached image:

1. With a DGN open and the WMS imagery attached, launch the Raster Manager. On most
workflows in OpenRoads this can be found on the Home ribbon under the Attach Tools shown
below:
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Raster Manager

2. With the Raster Manager open, select the active imagery that a file is going to be created from.
3. Go to the Edit menu on the Raster Manager and select the Merge command:
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Merge Command




4. At this time the image extents will need defined. This should accommodate the entire project
extents unless it’s a large project, at which time consideration should be given to possibly
creating multiple image attachments. In this instance, a block will be used to create the image.
Follow the prompts to draw a block around the project extents and when complete a dialog will
display requesting the Merge Options.

S
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BB Raster Manager: 1 of 1 listed
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Defining Image Extents
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5. Onthe Merge Options panel, settings for the extract image can be set. Care should be given to
the settings on this panel as deviation from the recommended settings can cause image sizes to
quickly expand with little perceptible benefit. The following image shows the recommended
settings:

a. Elements to Process: Rasters Only

Create New Attachment(s): Enabled

Resolution — Set Using: Pixel Size and DPI

Pixel Size for both X and Y: 0.5

DPI for both X and Y: 600

Output — Single File, Internet TIFF64

Output Options — Format Compression: JPEG Minimum Loss

™m0 oo T

Elements to Process: | Rasters Only ~ o
Create New Afiachment(s) -
-~
] Fill Clipped Are Format
File Type Intemet TIFF64
Resdlution Color Mode RGB
c i JPEG Minimum Loss
Set Using: |Pixel Size and DPI ~
Vorld Area Pixel Size Number of Pixels  DFI Scale Sheel Size ‘Sheet Uit
x [essom ] [os000 | [7zn | [so0 | 2 | [1zn [~
y. [2081.5000 ] 05000 | [a183 | [s00 | 1 [3600.0072000144 | [s. |
Based On Raster: | c: wsers'stkuhin'pw_ywork \d0298915\Best Avaiable Imagery swms
‘ Output
Output Type: | Single File | |intemet TIFF64 | [_Output Options Cancel
Grid Definition: |\users\athuhn\ow_work\d0934797\2001841_BECKETTS_DUPONT_3Dseed.dan Q o —3

Model: | Default

Run

Merge Options Settings

6. Once configured, select the Run command and the image will begin to process by prompting to
create the new file in ProjectWise. Create the image with the naming/settings desired. Note
that the default is to use the same name as the file the image is being created from.
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7. At this time the processing begins and the session will appear to be inactive. During this time,
the merge command is downloading the appropriate resolution imagery from the WMS imagery
and compiling the image requested. This may take a few minutes to complete. Upon
conclusion, a new raster attachment will show in the Raster Manager. If the display is disabled
for the WMS imagery, the block of the new image should remain.

W View1- Top, Default [s E= =R =

— e o Ace o m e o e e

=

File

View Display Settings Tools Utilities
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& (G Best Available Imagerycwms v [ 2001841 8.

& (@ 2001841 BECKETTS_DUPONT_3Dseed. i & 2001841 B.

REBREEEN SR O oo M-

A&

Y [1393.2761
Z | 0.0000

Created Raster Attachment

8. At this time, it’s highly recommended to switch back to ProjectWise and through either
ProjectWise Explorer or the Local Document Organizer, Update the Server Copy for your itiff
image so it is uploaded to the system. Alternatively, it can be checked in when the file is closed.

From this point onward, the created itiff image(s) can be used as the background image for the project
and lessen reliance on the WMS imagery service. Also, with the settings provided, the resulting image
should be easily portable and perform well. In the above example, the resulting image was
approximately 30 MB for the entire area shown.
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In addition to manually configuring the settings, CAD Support has created an Image Merge Presets.mrgx
file that can be used to apply the above settings automatically. This file can be found at pw:\\indot-
pw.bentley.com:indot-pw-01\Documents\Resources\XWMS\Merge Presets\. This file can be used in
one of two ways. The first is attaching it during step 4 of the above. To do so, change the Options on
the Merge command from Open Dialog to Load Preset File as shown below.

B Merge L\X’ — >

Options: | Load preset file "
Preset File: | rkd0369095\Image Merge Presets.mrgx

Area: | Block

Use Fence

Loading Merge Presets File

Proceeding this way will eliminate steps 5 and 6 and proceed straight to processing and placement in
ProjectWise.

Alternatively, if Step 4 proceeds with the Open Dialog, on the Merge Options dialog, there is a button to
Load Preset File where the file can again be selected, and it will apply the settings discussed.

E‘J Merge Options
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Optio

BIf'| nad Preset File || Rasters Only > Use Line Mappin

Create New Attachment(s)
[J Fill Clipped Area

Resolution

Set Using: | Pixel Size and DPI ~

Load Preset File


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CResources%5CXWMS%5CMerge%20Presets%5CImage%20Merge%20Presets.mrgx
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CResources%5CXWMS%5CMerge%20Presets%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CResources%5CXWMS%5CMerge%20Presets%5C

3.1-3 Approximating Raster Transparency using Contrast and Brightness
Applying transparency to aerial imagery in ORD has been quite problematic since INDOT has been using
the application. Several methods have been attempted to properly apply transparency to aerial
imagery, but none of them have proven to be successful. CAD Support has discovered an indirect way to
apply transparency—and that is by adjusting the aerial imagery’s brightness and contrast settings. The
process for adjusting these settings on an itiff file in Raster Manager are explained below:

Note: These following steps are only creating an approximation of raster transparency using the Contrast
Brightness tools of raster manager. In this method, the imagery will continue to be fully opaque and
traditional transparency should be used if the situation necessitates it.

1. With your .itiff file selected in Raster Manager, go to Utilities menu > Contrast Brightness.
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Contrast Brightness in Raster Manager

2. On the Contrast/Brightness dialog that appears, adjust the settings as desired. As a general
guide, CAD Support has discovered that setting the Contrast to -20 and Brightness to 50
roughly approximates a 50% transparency appearance when plotted.

ﬁ Contrast/Brightness — e
Contrast: | -20 2100 | € I > 100
Brightness: | 50 -100 | <€ B > 00

Contrast/Brightness Dialog




You can observe the difference in appearance on your sheets. Again, you can adjust the settings as
desired to suit your needs.

Aerial Imagery without Contrast and Brightness Changes

Aerial Imagery with Contrast and Brightness Changes

NOTE: In addition to using the Raster Manager to change the contrast and brightness settings for your
aerial imagery, you can also make these changes via your plot settings in Print Organizer. Please refer to
our INDOTWise 5.1 Plotting document for details on how to make these changes.
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3.2 Map Insert Application

1. Locate the Map Insert link in the Explorer window of the MicroStation platform. This can be
found in the Links tab of the Explorer window, under INDOT > INDOT Info.

Explorer > 0 X
LA File

¥ Items

Eﬁ Resources
| OpenRoads Model

L& sSheetIndex

t IR SIE SR SIE SIE 4

E Links
O - =- QQ,

b B Active Directory
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> % Bentley LEARN
4 "B INDOT

P g | Civil Cell Videas

b & ! Documentation

4 7 INDOT Info

€ Map Inseﬂ’
> @ INDOT Helpdesk Infarmation

IN.gov

Map Insert Link

2. Click on the Map Insert link or copy the following URL to the web browser navigation (INDOT
Map Insert (arcgis.com). NOTE: The Map Insert Tool prefers Chrome, Edge, or Firefox.

INDOT Map Insert Tool

+ MG o 2] B:s o vuoo o = e

INDOT Map Insert Tool



https://experience.arcgis.com/experience/bca834691cd643f09f98657a7e2538ab/page/Page/
https://experience.arcgis.com/experience/bca834691cd643f09f98657a7e2538ab/page/Page/

At startup, the entire State of Indiana is displayed. To zoom in to a specific area of the state you
can use the mouse wheel. By clicking the left mouse button and holding it down you can pan
the view.

Searching: To zoom to a desired location, enter one of the following: county name, district
name, project des#, or address. You may optionally select the type of search in the drop down.

%

SPMS Project
Districts - INDOT Districts

County Boundary

<N <M<

Indiana_Composite_Locator_W2

Performing a Search in INDOT Map Insert Tool



5.

6.

The Layers toolbox allows you to toggle on/off which layers are displayed in the view, and also
provides you with a legend to denote the various layers. Click on the Layers button in the top
right corner of the page to access the toolbox. Use the eye icons to toggle the layers on/off on
the Layer tab and click on the Legend tab to see a legend of the various elements that are shown
on the current view of the map. NOTE: Some of the layers will be grayed out upon initially
opening the Map Insert Tool. This is because such layers are dependent on the zoom level you
currently have on the map. If you wish to toggle on/off such levels, zoom in on the map to your
desired area such that those layers can now be seen.
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Layer Legend
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Layer Tab Legend Tab

Once you have the area of interest displayed and the desired layers turned on, use the Print
button to create the Map Insert image.

Print Button in Map Insert Tool




7. On the Print template tab of the Print/Export window, enter a title for the map and select the

applicable template. You may need to test the sizes to find the desired output. Note: The
MAP_ONLY template prints only the map, omitting any marginal information from the output.

Print/Export

Print template Print result

Title

ArcGIS Web Map
Template

A3 Landscape

Advanced

[[] Praview print extents

Print/Export Window

For additonal printing options, click on the Advanced dropdown arrow.

Print/Export

Frint template Print result

Title
ArcGIS Web Map
Template

A3 Landscape

Advanced

[[] Preview print extents

Advanced Dropdown Arrow




a. The following options are available:

Vi.

vii.

viii.

Map printing extents—Defines the method that the print service uses to
calculate the printed extent of the map. There are three options: Current map
extent, Current map scale, and Set map scale. Note that if you select the Set
map scale option, you will be given a field to manually enter a desired scale.
Enter information in the optional Author and Copyright fields if necessary.
Check the Include legend check box if you wish to have a legend displayed on
the printed map.

Check the Include north arrow check box if you wish to have a north arrow
displayed on the printed map.

Select the appropriate unit for the scale bar on the printed map from the
Scalebar unit dropdown menu.

Print quality—Allows you to update the resolution of the printed map in units
of DPI (dots per inch).

Check the Include attributes checkbox to include the feature's attributes in the
feature collection layers. This is only applicable to custom print services that use
the feature attributes, for example, to display a table of features and their
attributes.

Check the Preview print extents checkbox to see a preview of the printed map
extents upon clicking the Print button. NOTE: This only applies when the
Current map scale or Set map scale options are enabled for the Map printing
extents setting. If the Current map extent option is selected, the full extent of

the map that is being displayed will automatically get printed. The extents are
denoted by a black rectangular border with blue shading within it, as shown in
an example below:

Preview Print Extents



9. After all options have been set with the applicable values, click Print to submit all information to
the print service. You can then click on the Print result tab of the Print/Export to window to
view the print operation as it’s being processed.

Print/Export

Print template Print result

ArcGIS Web Map

0
L

Print Processing

10. Upon successful processing, you can click on the created link to access the printed image.

Print/Export

Print template Print result

Bl ArcGIS web Map

Successful Processing and Created Link
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11. Clicking on the link will open a new tab in your web browser displaying the printed image.

Printed Image

12. Right-click on the printed image and save it to an applicable location on your computer.

T

Open image in new tab
Save image as...

Copy image

1Y

Copy image address

Create QR Code for this image

[-l Search image with Google
in
T p—
—

Get image descriptions from Google P

T

Inspect

=)

s CEEEE T i

Saving the Printed Image

13. With the printed image now saved to your computer, you can use the standard Windows drag-
and-drop procedure to upload it to your desired location in ProjectWise.
14. Within the file you want to add the image to, attach the image as a raster.



3.3 Bing Maps Imagery

Bentley has now directly integrated the use of Bing Maps into the base MicroStation platform and is
extended to products built on it—such as OpenRoads Designer and OpenBridge Modeler. This
functionality can be of beneficial use on appropriately geocoordinated files to verify survey data.

Note: While this imagery can provide a quick check for geocoordination and other needs, it should be
considered a secondary source as it may not fit accuracy needs and there may be inconsistencies with
other agency provided imagery. Finally, it may not be suitable due to the age of the imagery. For those
situations that require a higher level of accuracy, please continue to use the provided Web Map Service
imagery discussed earlier in this chapter.

Prior to the release of the 2023 MicroStation Platform, the Bing Maps functionality could be found
under the view attributes for a given model and enabled there. This has been moved in the 2023
release and is now directly accessible from the View controls toolbar on each window:

B View 1, Default
Mol b PLONOG D BE| &3 G

Bing Maps on View Controls

It can also be found as part of the Geographic Toolbox:

&9 Qb

Geographic Toolbox

Both options will provide several controls to allow Bing Maps to be displayed as background imagery in a
geocoordinated file. For the purposes of this discussion, the Geographic Toolbox version will be looked
at, as it has some additional controls.



Map Type: MNone i
Elevation Offset: | -1.0000

Transparency: G 1] -

Target Views: ‘I|E|3|4|5|5|?|8

Apply Cancel

Assign Background Map

The Geographic Toolbox version is a modal dialog, meaning that other tools cannot be accessed while
this tool is open. It has the following controls:

1.

Map Type
a. None - Default, no background map
b. Road — Basic road map display
c. Aerial — Aerial imagery
d. Hybrid — Combination Aerial imagery and roadway labeling (road names, route shields),
along with some roadway overlays.
Elevation Offset — 3D Only, allows specified elevation offset to prevent imagery from overlaying
elements.
Transparency — Controls transparency of imagery
Target Views — Specifies the Views the selected imagery settings would be applied.

A workflow using this tool would be as follows:

1.

NoukswnN

Open a geocoordinated file, or apply appropriate geocoordination to an existing file where
necessary.

Select the Assign Background Map tool from the Geographic Toolbox.

Select the Map Type desired.

If 3D, specify the Elevation Offset.

Specify the desired Transparency.

Select the Target Views to apply these settings to.

Select the Apply button to enable the selected imagery and settings to the selected views.



With these steps, the background imagery will then pull from Bing Maps. Please note that unlike the
WMS imagery, this background map is not considered an element and cannot be cropped, merged, or
interacted with. Also, it will not affect Fit View extents and these will still only use the extents of your
active data when fitting the view. An example of the Hybrid option is shown below:

B iew!, Defoutt
E-8u-b-i PLOOYD EEIINS

—E:375:N

E350.N

Lo E300,N s

Hybrid Bing Maps Option

The steps to apply Bing Maps through the View Controls are similar—the only difference being that
steps 6 and 7 are not necessary. Using this method, it should be noted that Bing Maps imagery settings
are only applied to the active view.
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4. Geospatial Context Workflow

Newly released as part of the MicroStation 2023 platform, the Geospatial Context workflow allows users
to attach geospatial data to their files. The inclusion of this toolset allows for information of the
following types to be easily attached—and in some cases—directly imported into CAD files. Some of the
geospatial sources that can be attached to files include the following:

e Integrated Bing Map Imagery
e Web Feature Services (ESRI and OGC)
o Web Map Services (ESRI and OGC)

Note: INDOT CAD Support will not be able to assist in locating specific GIS datasources, and any
questions on what data may be available should be directed to the INDOT IT — GIS Support group.

Also, while technically not part of the Geospatial Context workflow per se, users are able to import
terrain data from GIS datasources. Additional information on this functionality can be found in Section
1.8 of the current INDOTWise 5.1 ORD Plans Production document.

4.1 The Geospatial Context Ribbon

The Geospatial Context ribbon can be accessed by loading the Geospatial Context workflow from the
MicroStation/OpenRoads Designer interface:

ﬂ |Geospatial Context E N
ﬂ OpenRoads Modeling -

 OpenRoads Drawing Production

l‘Sur\.rey
Cot Geotechnical
" Geospatial Context
Reality Modelin
Prop .
Drawing
4 SignCAD

Drainage and Utilities

DNt e

Geospatial Context Workflow



The Geospatial Context ribbon will then be displayed in the interface.

ﬂ Geospatial Context v (A H'._l:;EIE] * - f = = pw:ihindot-pw.bentley.com:indot-g

m Home
® b NN ¢ B NNNEY N O

Coordinate Bing New Delete Edlt Cuery  Clear Mew Attach Mew Attach New Attach = Element Fence
System  Maps Features Features = ArcGIS™ ArcGIS™ WMS WMS WMTS WMTS = Selection Tools
Geographic Feature Services Raster Services fa Selection

Geospatial Context Workflow

This ribbon contains the following tools (from L to R):

e Geographic — Coordinate System — This tool is used to attach/modify coordinate systems to the
DGN file

e Geographic — Bing Maps — Attaches Bing Maps; this is the same functionality as covered in the
previous section.

e Feature Services — New — Creates a connection to a Web Feature Service.

e Feature Services — Delete — Deletes a Web Feature Service connection.

e Feature Services — Edit — Configures the layers available in the Web Feature Service.

e Feature Services — Query Features — Creates CAD elements of selected GIS Layers and selection

area.

e Feature Services — Clear Features — Removes CAD elements queried from the Web Feature
Service.

e Raster Services — New ArcGIS — Creates a connection to an ArcGIS REST Map and Imagery
Service.

e Raster Services — Attach ArcGIS — Allows for the connection of pre-defined ArcGIS connections.

e Raster Services — New WMS — Creates a connection to Web Map Services imagery.

e Raster Services — Attach WMS — Allows for the connection of a pre-defined Web Map Service
connection. This is the same functionality as covered in section 3.1 of this document.

e Raster Services — New WMTS — Creates a connection to Web Map Tile Services imagery.

e Raster Services — Attach WMTS — Allows for the connection of a pre-defined Web Map Tile
Service connection.

For the majority of the readily accessible GIS sources available to INDOT, the Web Feature and Web Map
Services will be the tools that are primarily used. For discussion on the latter, please see section 3.1 of
this document.
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4.2 Attaching and Querying Web Feature Services

The tools under the Feature Services section of the Geospatial Context ribbon allow for the direct import
of GIS data to CAD elements. This can include linear, polygon, and point features. Along with creating
CAD elements, this will also append any GIS metadata to the created element that can be investigated
along with the elements themselves. The following will cover how to connect, import, resymbolize, and
view the properties of GIS elements.

Some important notes on the Web Feature Services connectivity:

e Please keep in mind that the symbology of the imported CAD elements are driven by their
definition in the GIS datasource and symbology overrides on import cannot be defined through
these tools. Users will need to adjust symbology post-import if the symbology from GIS is
insufficient for their needs.

e Web Feature Service Connectivity is maintained on a per-file basis. Any connections established
will be re-established when the file is opened by any user.

e In 3D files/models, all imported content will have a 0 elevation. It’s recommended to perform
imports into 2D files specifically created to hold this information. If adjustments are needed for
clarity, reference priority can then be used to adjust the level of the imported information.

e Bringing web feature service content into a file can result in enlarged file sizes. This will be
dependent on the quantity of elements and their complexity. Please keep this in mind when
determining how best to bring this data in, and whether it would be beneficial to keep separate
imports in their own files.

4.2-1 New Web Feature Service Connection
The first step to connecting to a Web Feature Service is through the Feature Services — New tool on the
ribbon.

Clear

Query
Features

Mew

Create a feature service connection &
(E=ri ArcGI5™ or OGC WES)

New Web Feature Service Connection
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This will display the New Feature Service Connection dialog as shown below:

Server URL : ~

Connection Name
User Name :

Password :

0K Cancel

New Feature Service Connection

The following fields are available:

e Server URL— Web address of the Web Feature Service; this field will remember a list of recently
used connection addresses.

e Connection Name — Name of the connection; can be pre-defined by the Web Feature Service or
set by the end user. This will also be used as a prefix for the level name for the imported
features.

e User Name — If necessary, the user name for the Web Feature Service.
e Password — If necessary, the password for the Web Feature Service.

Many feature services are freely available, and will not require a User Name/Password. In these
instances, do not enter account information. Others may require accounts to be configured, so please
reach out to the service provider for their access requirements.

In this example, both a linear/polygon and point feature datasets will be looked at and are provided for
illustration purposes only. The services being used are:

e Parcel_Boundaries_of_Indiana_2023 — Hosted/Parcel Boundaries of Indiana 2023

(FeatureServer) Linear/Polygon Features
e LRSE_Bridge Point— Hosted/LRSE Bridge Point (FeatureServer) Point Features



https://gisdata.in.gov/server/rest/services/Hosted/Parcel_Boundaries_of_Indiana_2023/FeatureServer
https://gisdata.in.gov/server/rest/services/Hosted/Parcel_Boundaries_of_Indiana_2023/FeatureServer
https://gisdata.in.gov/server/rest/services/Hosted/LRSE_Bridge_Point/FeatureServer
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Going to the link for the Parcel Boundaries, copy the address from the URL and paste it into the Server
URL field. Press the Tab key on your keyboard to confirm the connection and populate the Connection
Name field, or alternatively you can enter an appropriate and recognizable name. For this feature
service, no username or password is required.

Feature Service URL

& ] Mew Feature Service Connection *

Server URL : ||'rl1ps:;"fgisdata.in.gu:w;"ser\terfrestfsenricesfHosted;"Parcel_Boundaries_of_Indiana v|

Connection Name |Hosted_ParceI_Boundanes_of_lndiana_ZDZE |

User Name : | |

Password : || |

Feature Service Connection



When ready, select OK and the connection will be established and a prompt displaying all available
layers for query will be displayed. This connection only has one layer for the parcel boundaries
themselves. By default, all layers available will be selected. Select the requested layers if more than
one is available and click Connect.

] Mew Feature Connection Parameters *

Selected Features:

EI--@ Hosted_Parcel_Boundaries_of_Indiana_20
Parcel Boundaries of Indiana 2023

Cance

Layer Selection

Next, the other GIS source for bridge locations will be attached. The previous steps should be repeated
to attach the feature service.

106



4.2-2 Editing the Web Feature Services
With both feature services connected, select the Edit button on the ribbon to validate the connectivity
of the feature services.

—
b0 DT e 2 2

Mew Delete| Edit

Feature ArcGIS™ A

Feature Services
- - [ |

Edit

Change layer selection in connection

Edit Feature Services

Again, if a particular service contains more than one layer, these will be displayed based on if they have
been selected or not.

E’J Feature Connection Parameters *

Selected Features:

B Feature Connections
=-5kE) Hosted_LRSE_Bridge_Point
. i.v]o DOTRAH.LRSE_Bridge_Paint
EIQ Hosted_Parcel_Boundaries_of _Indiana
Parcel Boundaries of Indiana 2023

Active Feature Connections

When satisfied with the layers/connection selected, select OK to proceed.
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4.2-3 Querying the Feature Service
With the feature services connected and the layers selected, these can now be queried and have CAD

graphics created from their data.

0 i
WU W z5 | ¢ B B

Mew Delete Edit | Query | Clear Mew  Attach
Features| Features = ArcGIS™ ArcGIS™

Feature Services Ras

¥ Qu ery Features

Cluery features for active view extent

Query Features

Please note that the tool tip specifies that the Active View Extent is specified. When run, any features
that are within the active view extents AND those that even cross the active view extents will be
attached to the file. The following screen capture illustrates a sample alignment and the green, dashed
shape illustrates the view extents prior to the query.

= View1, Default
- b1 PPROVD

View Extents lllustration



Selecting the Query Features button will kick off the import from the feature service and its
progress/status will be shown in the MicroStation/OpenRoads Designer message center.

L | Query Complete (170 features).

Query Feature Complete Status

With the query complete, the elements have been created. Based on the symbology definition received
from GIS for this particular layer, it appears that nothing has been created. To see if elements have

been created, hover over the view with the selection cursor and the features will show with a shadowed
selection.

Created Elements

This will illustrate that the graphics have been created, and the following sections will cover how to
resymbolize these graphics to make them visible for use if the GIS symbology definition does not
translate cleanly.



4.2-3a Linear/Polygon Features Symbology
As previously discussed, the GIS feature service controls the symbology that is provided to
MicroStation/OpenRoads Designer, and as part of the application of this symbology, each element has
its own discreet symbology. These imported graphics unfortunately do not utilize a Bylevel symbology
definition.

This section will cover an example CAD process to select these elements, set their symbology to a
Bylevel definition, and then adjust the symbology to something suitable for use. To start, select the
Element Selection tool, and ensure that the Extended Settings are enabled, select the Level selector
panel. On this panel, select the level name for the imported graphics. The convention for this level
naming is [connection name]-[layer name] and in this case resolves to
Hosted_Parcel_Boundaries_of Indiana_2023-Parcel Boundaries of Indiana 2023.

£% Element Selection — x

[
| &

Fal
Level

G_SURF_Top Mesh
Geom_Civil_Cell_Control
Grade_Finished

Hosted LRSE_Bridge ...
|Hu:usted_ParceI_B|:|ur1daries_nf_lndiana_ED23-Parcel Boundaries of Indiana 2023
HY_DE_Pond il
HY_DR_Trace Down Slope

HY_DR_Trace Slope

HY¥_DR_Trace Up Slope

Matchline

Morth Arrow

P Cell W

Selection of Created Level



Then load the Element Information panel if not already loaded. This will show all elements available on
the selected level, and from here the symbology can be adjusted to Bylevel. Select the Color, Line Style,
and Weight; and select Bylevel for their respective value.

4 ‘¢ Elements (170)
b ‘& Grouped Hole (4)
b L Shapes (166)

General L

Element Descrip “*Vares™*

Level Hosted_Parcel _Bound
Color BylLevel (0)

Line Style [mmill v
nieight syl

Class

Fill 1]

Template | 1

Transparency (-~~~ "~ 2

Priarity -3

Element Information and Setting Bylevel Symbology

One thing to keep in mind is that this particular symbology does have per element Transparency also
applied. In this specific scenario, it has been set to 100% transparency, preventing the elements from
displaying at all. To address this, set the Transparency to 50% to get an initial gauge of element display.
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With the transparency, set, it should also be apparent that element fill is enabled for these features, and
in this case, it might be advantageous to set this display to no fill which will preserve the edges of the
polygon and not interfere with the display of other graphical elements.

General E [ EE Stand
Element Descrip **Varies™*

Level Hosted_Parcel _Bound

Color ByLewvel (0)

Line Style ByLewvel (0)

weight o

Class Primary

No Fill "

B E P 1

oK

Cancel

BylLevel

No Fill

Disabling Fill
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With these settings adjusted, the display would appear like the following. Note that the green line
illustrating the original view extents crosses the features that have been imported, showing how the
Query command defines its extents.

. efsut [Displyset] =)
- b~ L[PLROYN EE| &g

Imported Feature Initial Cleanup

With the symbology cleaned up and using Bylevel symbology, their display can be then adjusted through
the Level Manager to the desired color/linestyle/weight. For this example, the settings have been
adjusted as shown, with the resulting final appearance. Note that this is an exaggerated symbology for
illustration purposes.

oa Level Manager - X
Levels Filter Edit
:’:/ﬁ“’ Symbology: |Bylevel =~ ?(ncme] ~ A g ﬁg )ﬁ
= GIS Imper... A MName =) = = Used ~
C T A Default Oo 0 0 .
= All Levels Hosted LRSE Bridge Point-DOTRAH_LRSE Bridge Point []0 —0 0 .
=Y Filters I Hosted_Parcel Boundaries_of Indiana_2023-ParcelBo.. [ 128 - —-—- 2 4 .
BD_Batch Plot Border o [ 0
BD_LS Stamp Oo 0 0
BD_PE Stamp Oo 0 0
BD_SHT o 0 0
BD_SHT_Attribute Exchange o 0 0
BD_SHT_Attribute Exchange - Sig-Date Oo o o
BD_SHT_Clip Boundary (Mo Plot) O 207 o 0
BD_SHT_Frame Oo 0 1
BD_SHT Legend o 0 0
BD_SHT Map Image o 0 0
BD_SHT_Map Tt 4 0 0
BD_SHT_Morth Arrow Oo 0 0
BD_SHT_Mumbering Oo 0 0
BD_SHT Ref Boxes o 0 0
S 2 RD SHT Table Gridlines Mo n n ©
Active Level: Default 1292 of 1292 displayed; 1 selected;

Level Manager Symbology



B View 1, Defaul Diplayset] =
@-Ex-b-PPROYD EE &K ==

Resulting Symbology

4.2-3b Point Feature Symbology
When importing point features, these too receive discreet, per element symbology settings. However,
their nature as point features provide additional complications for visibility that can be addressed
through the following steps.

Continuing from our previous example, our sample project has a small structure located along it that is
located using the LRSE Bridge Point feature service. To enhance clarity, all other data except the view
extents have been disabled. After performing the query, a point has been placed in the extents
representing the small structure. This point has been selected to increase its visibility as well. The
symbology as initially defined will only display as a small white dot.



Point Feature Location

To increase the visibility, the same process can be used as with the linear features weight to Bylevel, and
adjust any transparency as needed. Color cannot be adjusted and linestyle is unnecessary to adjust. In
this instance, setting the weight of the level to 10, provides good visibility. Note that the weight is a
dynamic setting on the point, so the symbology will remain the same size regardless of zoom level. Also,
through this method, it should be noted that there was another small structure that was at the very
edge of our view extents that wasn’t otherwise visible.

‘az Level Manager — »

Levels Filter Edit

:’9? Symbology: | Bylevel = ?(none]' J b QE )f
=1 [GIS Impor... A Name
+ A Default
] ‘ Hosted_LRSE_Bridge_Point- DOTRAH_LRSE_Bridge_Point
= ? Filters Hosted_Parcel Boundaries of Indiana_2023-Parcel Bo...
BD_Batch Plot Border
BD_LS Stamp
BD_PE Stamp
BD_SHT
BD_SHT_Attribute Exchange

il
all
=
]
>

oo

= All Le

=]

g P e
=Y
-

@
'
|
|
'
|
'

~

BD_SHT_Attribute Exchange - Sig-Date
BD_SHT_Clip Boundary (Mo Plot)
BD_SHT_Frame

BD_SHT_Legend

BD_SHT_Map Image
BD_SHT_Map Txt
BD_SHT_Morth Arrow
BD_SHT_Mumbering
BD_SHT_Ref Boxes

S 2 RN SHT Table Gridlines

Active Level: Default 1292 of 1292 displayed; 1 selected;

JOooooooooooooooono @

cooococooooCcOoOoooo
CoococooOD o000 0oo

Point Feature Level Weight



Resulting Symbology

Additional Notes on Point Symbology:

Depending on the point feature imported, a shared cell model may be imported into the DGN at

the time the query is run. In this instance, a new model called esriSMSCircle has been created
consistent with the shared cell in use

r

+ 1) @2 Y X

Type 20/3D MName

Description
C.)_] L1 Default Master Moc
O3 | esriSMS5Circle Master Moc

Properties

v@ax

4 7 Elements (1)

4

B ltems

% DOTRAH.LRSE_Bridge_Point

General

N ™

m

Tevel

Color

n Shared Cell: esriSMSCircle I

(None)

Depending on the shared cell that is brought in, the scale may be adjusted to increase visibility,

which will be dependent on the settings provided by the GIS feature service.



4.2-4 Deleting Web Feature Service Connections
To delete a Web Feature Service Connection, select the Delete button on the ribbon.

AT s BN 2¢

Mew |Delete Cuery

Clear M
Features | Arc

Feature Services

Delete

Delete a Feature Service Connection

Delete a Web Feature Service Connection

This will present the list of active feature service connections available in the open file. Simply select the
check mark next to the connection that is to be removed and select Delete. This will prevent the
connection from being queried on subsequent operations but will not remove any graphics that were
created by it.

E’J Delete Feature Service Connections >

Selected Connechions:

[ i) Hosted_LRSE_Bridge_Point
i.] |21 Hosted_Parcel Boundares_of Indiana

Delete Feature Service Connection
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4.2-5 Clear Features
The Clear Features tool is used to remove all items that have been displayed by the Query Features tool.

— _
Ao Rg = Du(e¢| B X

Mew Delete Edit Cuery | Clear Mew  Attach MNew A
Fe Features| ArcGIS™ ArcGIS™ WMS

Featur Raster Servic
- - n

Clear Features

Clear all features from Model

Clear Features

Usage of this tool will remove these graphical features if the connection is still active. If a connection
has been deleted, the graphics will not be removed.

Note: Any graphic features that are removed using this tool will not retain any Bylevel symbology
settings that were previously defined. The resymbolization process will have to be performed again on
the new elements.

4.2-6 Reviewing Web Feature Data
One of the many advantages to bringing in Web Feature Service data is that not only are spatial
locations and boundaries provided, but each feature carries its accompanying metadata from the GIS
feature service. This section will cover what can be expected of these features.

Continuing from the previous sections, the resulting data with both our linear/polygon and point data is
as shown combined with aerial imagery and the project survey.

& View 1, Defut Displayset]
GE-6%-|b-i LRROVD EHRRE:

Combined CAD/GIS Data
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At this point, simply selecting on any of the import elements will expose the metadata that was brought
over with the feature from GIS. The following illustrates one of the parcels that was imported along
with one of the bridge points. Note that the Metadata information shows up in the Element
Information panel under a heading named after the layer it was imported by, and that all the fields
under the heading are provided by the GIS system. As with the symbology, the GIS Feature Service
provides this information, and it cannot be modified as part of the import process.

Properties * I X
E B View 1, Default [Displayset]
4 “Fh Elements (1 g
et mréw-bri POPO0OHD
4 (% Parcel Boundaries of Indiana 2023
b g ltems

General v

Geometry w

Material v

Extended v

Parcel Boundaries of Indiana 2023 -~

objectid 2446833

state_parcel_id 510530400017000006

parcel_id 51-05-30-400-017.000-006

prop_add ST RD 450

prop_city SHOALS. IN 47581

prop_zip

prop_state

local_id 9575

nguid um:emergency-uid-gis-PCL-95]

source_datadesc PARCELS
source_datasetid PARCELS.SHP
source_featureid 9575
source_criginator MARTIN COUNTY

loaddate 8/2/2023
county_fips 18101
county_id 21

dlgf_prop_addrezss ST RD 450
dlgf_prop_address_c SHOALS
dlgf_prop_address_z 47981-0000
dlgf_prop_class_cod 100

esn_zip 47581

esri_poname SHOALS

|atitude: 38.7507

longitude -86.7789

SHAPE__ Length 1848 5387

SHAFPE_ Area 115324.8680
Pattern Parameters -

GIS Metadata on a Linear/Polygon Feature
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Properties > o x
B View 1, Default [Displayset]
-~ _
4 ‘7 Elements (1) o~ &)~
4 % DOTRAH.LRSE_Bridge_Point : r
b @ ltems
| General L |
[ Geametry v | |
| Extended w | '
DOTRAH.LRSE_Bridge_Point ~ :
objectid 255150 b
from_date 6/19/2019 12:00:00 AM :
to_date f
event_id {63B2BB55-A1AB-4F29-B4AC- }
route_id 90000004500000001 H
measure 62544
record_status 5
nbi 032690
owner 1
created_by SBarre@jot_IN_gov
date_created 6/30/2023 12:26:23 PM
edited_by SBarre@ict_IN_gov
date_edited 6/30/2023 12:26:23 PM
locerrar NO ERROR
date_attr_effective  3/24/2009 12-:00-00 AM
globalid {DE6E7COC5-CB56-4A20-BB22-

GIS Metadata on a Point Feature

The metadata fields that are appended to the elements are part of what is called Item Type functionality
in the MicroStation platform. By appending this information in this manner, users can report and
annotate directly off these fields. If there is a specific need, please contact CAD Support to discuss and

determine the best way forward with any potential needs.
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4.3 Using the GIS Template Seed File

Thanks to the efforts of our internal Design staff, we have implemented a GIS template seed file
(General GIS Template.dgn) that contains several preconfigured connections to various GIS feature

services. This seed file can be found under the Template Documents\ORD-Connect Seed\GIS Seed
Templates folder in ProjectWise.

ElL. Template Documents

w2 DGN

|_:_|1_, ORD-Connect Seed

A7 GIS Seed Templates
£a € seed Files (20 only)
oy Sheets

-~ Standards Seed Files

U Survey Seed Files

- Seed

F-0D 554 Seed

Location of General GIS Template File in ProjectWise

Upon opening the seed file, you will notice that it is preconfigured to display the Road background map

from Bing Maps by default. If you wish to change the background map, you can do so via the Bing Maps
tool in the view window.

B View 1, Default

v &% v"-|¢ P LOOY D ED Sa R

Dixon Map Type: |Road =N -
6 ' Elevation Offset: | -1.0000 .
Transparency: G 0 - 1

Bing Maps Tool in View Toolbar

To view all of the preconfigured GIS feature service connections, simply click on the Edit button on the
Home tab of the workflow.


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CGIS%20Seed%20Templates%5CGeneral%20GIS%20Template.dgn

a Geospatial Context * W@ S H t_rg EE: * [% F pw:ihindot-pw.bentley.com:indot-pw-01*

File Home
B HEEEEE kO

® b

Coordinate Bing Edit JQuery  Clear Mew  Attach Mew Attach MNew Attach  Element Fence

ik

Mew

System  Maps Features Features  ArcGIS™ ArcGIS™ WMS WMS WMTS WMTS = Selection 100ls™
Sl = ﬂ Feature Connection Parameters .
Explorer
L8 File | Selected Features: ) |:
@ Items 1 E- . Feature Connections ~ ]
- EI .@ Hcsted _Highways_RO E|
i Resources - Highways
5 EI .@ Hosted _Incorporated_Areas_of_Indiana_Current ke
| DpenRoads Incorporated Areas of Indiana Cument L
= Eu l@ Hosted LRSE_Speed_Limits B
i) Sheet Ind, ; _ DOTRAH.LRSE Speed_Limits o
Jw Hasted LRSE_AADT
s Eﬂ ﬁ . DOTRAH.LRSE_AADT
[ @ INDOT] EI .@ Hnsted Parcel_Boundaries_of _Indiana_Cumrent
E Parcel Boundaries of Indiana Current
= l@ Hosted_PLSS_1
PLSS5 Guarter Section Boundaries
PLSS Quarter-Quarter Section Boundaries ﬁ
PL5S Quarter-Quarter-Quarter Section Boundaries |
PLSS Section Boundaries [
PLSS Township Boundaries /

Hosted _Streams_DrainageArea_DMR_RO

: .. StreamsDrainagefrea_DMNE_DOW
EI .@ Hosted _Township_Boundaries_of _Indiana
E, Civil Township Boundaries 2021 -
EI .@ Hosted_County_Boundaries_of _Indiana_Cument
.i\ County Boundaries of Indiana Cument
EI .@ Hosted_National_Wetlands_Inventory
MW Historic Wetlands
MW Historic Wetlands Project Metadata
MW Indiana Area
MW Wetlands
NWI Wetlands Historic Map Info
MWW Wetlands Project Metadata
EI .@ Hnsted Road_Centedines_of _Indiana_Cument
. Road Centerines of Indiana Curment
Hnsted LRSE_Functional_Classes
_ LRSE_Functional_Classes C
EI .@ Hnsted LRSE_Functional_Class '
. DOTRAH.LRSE_Functional_Class

EI .@ Hcsted BazinTeamz_DMNR_Water_[N_RO
i L A PasimTazme MKME WAlmtar 1K ~

Cance -

1 | ] _\_arl

E

Preconfigured GIS Feature Service Connections in GIS Template Seed File

Then at this point, it is simply a matter of working with the geospatial data via the processes highlighted
earlier in this chapter.
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5. MicroStation Platform - Plans Production

This chapter will first cover the standard INDOT naming convention for various types of MicroStation-
based drawings. Then what follows is a description of the processes involved with sheets that are
manually created from our DGN template document files. Examples will be given for the creation of title
and index sheets, and then there will be separate discussions of the specific plans production process for
Resurface and Traffic plans. For recommendations on sheet naming, please see section 4.4 which covers
a variety of potential sheets that may be included in a project or found in legacy data.

5.1 Creating Sheets from DGN Template Documents

The first step in creating sheets from our DGN template documents is to first make a copy of our

INDOT US SVFT 2Dseed.dgn file into your project. This serves as a template file that you can work
from. Then within that file, you can import in the necessary sheet model from one of our template
documents—namely D size_sheets.dgn and Ltr_sheets.dgn—depending on the plan sheet size that
you’re working with. These files can be found within the DGN folder under Template Documents in
ProjectWise. What follows are the next steps in the process for creating a title sheet and for creating an
index sheet. For the following examples, full size sheets for road plans will be used.

5.1-1 Creating a Title Sheet
With the seed file copied into your project and named according to standard title sheet convention,
perform the following steps:

1. With the title sheet file open, open the Models dialog and click on the Import Models button.

=
" = r— :
+ ‘o .

Type 207230 Name * Description 4 Design File
Default Master Model < c\users\psmo..\Sht Title.dgn

Import Models Button in Models Dialog


pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CINDOT_US_SVFT_2Dseed.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CDGN%5CD%20size_sheets.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CDGN%5CLtr_sheets.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CDGN%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5C

2. Onthe Import Model From File dialog that opens, navigate to the location of the D
size_sheets.dgn file in ProjectWise and click Open.

& Import Model From File *
Select
Folder
‘L:DGN v“ Bl=EE A
#ln Bl

Name File Name Al
F7¥M Sheets

/ #] Consultant Ltr_sheets.dgn Consultant_Ltr_sheets.dgn

o/ #D size sheets.dgn b D size_shests.dgn

7 B Ler_sheets.dgn Ltr_sheets.dgn v
< >

Adgress: [ Vindot-w.bentey. comindot pu-81\DoaumentsiTemplate Documents DEN|D size_sheets.dgn ~]

Description: ‘ Current INDOT D-Size MicroStation Sheet Models. ‘

File Name: ‘ D size_shests.dgn ‘

Application: Al appleatons v

Extension: |=dgn |

Open document as read-only

Selecting D size_sheets.dgn File

3. ASelect Models dialog will then appear with a list of all the sheet models that reside within the
D size_sheets.dgn file. Select the appropriate title sheet model in this list and click OK. For this
example, we will select the RD_Title Sheet model.

k4 Select Models x

File: | D size_sheets.dgn

Type 2D/3D MName ~ Description *
RD_Pipe Material Sheet Read Pipe Material Sheet
RD_Plat Sheet Road Plat Sheet

RD_Summary Sheet Read Surmmary She
RD_Title Sheet Road Title Sheet %
RD_Title Sheet ROW Road ROW Title She

RSM_Prelim Drawing Sheet R5M_Prelim Drawing Sheet
5G_Detail Sheet Traffic Signals Detail Sheet
SG Title Sheet Signals Title Sheet A

13hJhdhJhdhdbdhd
DOoO00goooo

Selecting Title Sheet Model from D size_sheets.dgn File

4. A new title sheet model will now be placed into your file.
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b % Configured Library

b B Ben
> & IND,

ley LEARN

Models

Lhed oy

Type 20/3D Mame ~
01 ] Default

Description

Master Model

IND:
OF

IANA DEPARTMENT
TRANSPORTATION

ROAD PLANS

ROUTE: PRG4L FROM: RP 040  TO: RP O+L

PROJECT NO.

P.E.

Title Sheet Model




There are a couple areas of the title sheet to note. At the bottom right-hand corner, you will see the
project Des Number, Contract Number, and Project Number fields already populated. These fields
automatically populate based on the properties of the project (“Work Area” in ProjectWise terms). A
look at the document properties of the title sheet will show this information.

&1 sht Title.dgn - *

General Security Aftibutes  More Attibutes  Audit Trail  Work Space  Spatial
| Universal Title Sheet ,
| PLANTYPE v|

o DESCRIPTION: |BrHepl.Comp.Corrt.Pres.Conc.BuIb T-Beam |

A Locamion: Bridge over US 41, 462 miles S of I-70, SR 641 ramps over US 41 (SB), (FH 14)
k| AREA ENG. COUNTY. NO. l:l
PLANS PREPARED BY: | | PHOME NUMBER
- PROJECTRCUTE |PR 641 AADT. V.P.D.
FROM RP TORP AT RP AADT. VPD.
0+0 0+
il | | | ony ves
4 i’RC\I. NO. OONTT GROSS LENGTH BRIDGE LENGTH DIRECTIONAL DIST. %
TRUCKS
PROJ. NO. PE NET LENGTH ROWY LENGTH

| [ | | | |:|%D.H.\.r.

PROJ. NO. RW MAX. GRADE TOTAL_LENGTH

| | [ | [ooooooo | sesenseeen| | wes

ERIDGE FILE PROJ. DES. CRIT:
STRUCTURE NO.
1! FUNC. CLASS.: RANSPORTATION
SPECDATE  COUNTY  SURVEY BOOK DESIGNATION URAL | URBAN: 5 DATED
. ANS
LATITUDE _ LONGITUDE ~ CONTRACT _ PROJECT REAIN

N 3973710 | |W 8773811

DESIGNATION
Save Undo

$PAGE_NUMS | of FTOTAL PAGESY
PROJECT
7654321

Automatically Populated Information on Title Sheet
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Then at the top right corner are the Traffic Data and Design Data tables. This information gets
populated from the Attributes tab of the document properties. Note that if you have the title sheet
open when you enter this information on the Attributes tab and save it, you will need to close and
reopen the title sheet for the changes to take effect.

| & sht Title.dgn - X

°| General Securty Attributes More Attibutes  Audit Tral WorkSpace  Spatial
1 Universal Title Sheet
| PLAN TYPE \/|

DESCRIPTION: |B( Repl. Comp Cont.Pres Cone.Bulb T-Beam |

LOCATION

Bridge over LIS 41 4 62 miles S of 170, SR 641 ramps over S 41 (SB), (PH 1] ‘
) AREAENG.COUNTY.NO. [ |
PLANS PREPARED BY: | | prione numeeR
§ PROJECTROUTE [PR 61 aant [ | [ [ven TRAFFIC DATA
) | FROM RP TORP AT RP
o0 = | | l AADT. VPD. YRR i 3 TP
onv [ ][ Jues AADT. [ V.PD.
H | PROJ. NO.CONST GROSS LENGTH |BRIDGE LENGTH‘ orecTowLoer. || % DAY ) 5 VER
PROJ. NO. PE NET LENGTH ROWY LENGTH TRUCKS l:l DIRECTIONAL DISTRIBUTION %
I | I | [ Jwosv TRUCKS % AADT,
PROJ. NO. RW MAX. GRADE TOTAL_LENGTH % D.H.V.
[ | | [ooooon | DESIGN SPEED: weH

BRIDGE FILE PROJ. DES. CRIT.. |NEW CONSTRUCTIC ~ D E SI G N DATA
08335
sTRucTURE o (06385 | FUNG. CLASS.. | MAJOR COLLECTOR ~

DESIGN SPEED 55 M.P.H.
|5FE° 2= I it ‘ TUR"“ B°°K| f;;ﬂfgm‘ ruRALfuRgan; [RURAL ~ PROJECT DESIGN CRITERIA NEW CONSTRUCTION (FREEWAY)

I.ATITUDEV LE:GITUDE ‘Z:)NTRACT PROJECT TeRRran;[LEVEL ~] FUNCTIONAL CLASSIFICATION MAJOR COLLECTOR
N 393710 ’m‘ ,W‘ ’W‘ IACCESS CONTROL: RURAL/URBAN RURAL

| TERRAIN LEVEL

ACCESS CONTROL FULL

Populated Design Data Information from Attributes Tab
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5.1-2 Creating an Index Sheet
To create an index sheet, you will perform the same initial steps as you do for the title sheet, where you
create an index sheet file from a seed, and then proceed with the model import from D size_sheets.dgn.
The only difference is that at the Select Models dialog, you will select the RD_Index Sheet model.

&1 select Models * |
File: | D size_sheets.dgn
Type 20/3D Mame © Description A
E | RD_Detail Sheet Road Detail Sheet
[3 ] RD_Index Sheet Road Index Sheet ROW Off _
5 Ll RD_Pavement Marking S... Road Pavement Marking Sheet
3 Ll RD_Pipe Material Sheet Reoad Pipe Material Sheet
[8 L] RD_Plat Sheet Road Plat Sheet
[g Ll RD_Summary Sheet Read Summary Sheet
[8 ] RD_Title Sheet Road Title Sheet
(A _l  RD Title Sheet ROW Road ROW Title Sheet 7

Selecting RD_Index Sheet Model

A new index sheet model will now be placed into your file.

sfigured Library

tley LEARN

o B Models - x
Lhesm v x
Type 20/3D Mame ~ Description e
Q1 ] Default Master Model

RD_Index Sheet Road Index Sheet ROW Off
] RD_Title Sheet Road Title Sheet

Index Sheet Model

There are a couple areas of the index sheet to note. First is the Index table in the top right. A few rows
are in the table initially. To add rows to the table, simply copy and paste the bottom row, as necessary.
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INDEX

SHEET NO. DRAWINGS INDEX
1 TITLE
2 INDEX AND GENERAL NOTES
77977 OO0 ~

Cell: DS_MISCTBL WC ' Line
Level: Default

Copying Bottom Row of Index Table

Then for the General Notes table in the top middle section of the sheet, you can navigate to the INDOT
Tools workflow, click on the Cells tab, and select the Tables-Legend-Notes Cells cell library to find the
general notes that can be placed in this table.
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& | INDOT Tools @8- oHER «- 4 205 -
Home Applications II Cells II Annotation Tools Survey Traffic

pwi\\indot-pw.bentley.comindot-pw-01\Documents'_Testi

e : = p ~
Y~ ﬁ ,l'“,, % * r$ Q ﬁ b EI:E

Place Set Coun Imperial Metric  Lighting Patterns ~ Pavement Signs Symbol Scalg
Cell Tool Active Scale=1 | District Maps Detail Cells Detail Cells ells”  Cells  Markings Cells ©ells~ “Cells  Bars

E |2 ©

MOT Professional

Tabls-LEgend-Nota
ells Cells  Stamps

Cell Tools Cell Libraries

e R 1o 1 A i Y Y R e

J View 1, RD_Index Sheet

=4 R POV DEE|E Y &

Tables-Legend-Notes Cells
Tables-Legend-MNotes Cell Library

GENERAL NOTES

Place general notes here.

Adding General Notes




5.2 Resurface Plans

The following sections discuss MicroStation platform and Microsoft Excel resources to be used in the
development of a set of resurface plans.

Resurface plans can be composed of one .dgn file with multiple sheet models, or several .dgn files each
having a single sheet model. Regardless of the method that is used to create these plans, they should be
produced using the 8.5” x 11” borders available in the Ltr_sheets.dgn template file.

Datasource Folder Document View Tools Window Help
j ﬁﬁ E‘,; Op 8p %o EEEE @ _ o4 - Search|5§2 V|D- _ :Interface_PROJECT

QZI - E:> - L’j - Addressm Jcom:indot-pw-01\Documents\ INDOT Workspace\ORDWorkspace\Template Documents\DGM\Ltr_sheets.dgn V|D'

©-{= INDOT Workspace ~ | Bl st @ Spatial
- Development

MName
t-L_ IHSDM Resources -
5[ InRoads jd Consultant_Ltr_sheets.dgn

[

: =l

- Managed A D size_sheets.dgn
- OpenRoads *
== ORDWorkspace
@ INDOT

-7 INDOT_Standards
-4 Template Documents

Ltr_sheets.dgn Location

This file contains a title sheet model, and a set of four sheet models that can and should be used to
develop each of the sheets in a set of Resurface Plans. These sheet models are:

- Ltr. Title Sheet. This sheet model is the standard title sheet to be used with 8.5” x 11” plans.

- Ltr. Detail. This sheet model is a standard, empty 8.5” x 11” border sheet oriented in portrait.

- Ltr. Landscape Detail. This sheet model is a standard, empty 8.5” x 11” border sheet oriented in
landscape.

- Ltr. Detour Sheet Signing. This sheet model is available to be used for the Recommended Detour
Signing sheet.

- Ltr. Index. This sheet model is for index sheet content.

For the detail and index sheets, there is also a corresponding sheet model for the placement of an
engineer stamp.

These plan sheets should follow all drafting standards as specified the INDOT CAD Standards Manual,
available for download from the INDOT CAD Support web page. See the Indiana Design Manual for
information regarding the sheet content.
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5.2-1 Ltr. Title Sheet
This sheet model should be used as the title sheet for all plans created using the 8.5” x 11” format. This
and all other sheet models in Ltr_sheets.dgn take advantage of attribute exchange information which
allows population of fields using the Universal Title sheet.

While in the open file, import the sheet model titled Ltr. Title Sheet model from Ltr_Sheets.dgn. When
you open the newly imported sheet model, it will appear as shown in the illustration below.

g 3
£ H
§ | CONTRACT NO. R-25542 INDIANA DEPARTMENT OF TRANSPORTATION TRAFEIC DATA
: . AADT. [ 2010 e
ROAD PLANS AADT.[ 014 | Prol 75 vro &
g DAY 3 vEH]
£l PROJECT DESCRIFTION Dvacsong! Duriion el
TRUCKS % AADT, JF
Resurface Plars Tmwony 3
DESIGN DATA -
PROJECT LOCATION DESIGN SPEED Gl
PROJECT DESIGH CRITERIARTIAL JR (NOW-FREEWAT)
ocal B4 From Fahon Rl b US 41 aed 6918 Ty Tach Access B Fusclirsal Cam STATE COLLECTOR
RURAL URBAN L
CROSSLENGTH LD ML TERRAIN ROLLING
ACCESS CONTROL NOE
% NET LENGTH Lo ML
m
'z
c
@ P — g arin
A s s = fr— sersams
oy o
1
O ves. wo. coor2s0
=
I
]
>
(2]
7
*
ware 3516 DATER
cemnraen o i
3
ABHROVED FOR LETTING 4
Andana Depistment o Transgurtason !
ST SIS Sate 2014 -
\r B b usie with e A T

Ltr. Title Sheet Model

5.2-1a Placing the Location Map
Please refer to section 3.2—which covers the use of the INDOT Map Insert Application.
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5.2-1b Placement of County Cells and Project Location Symbol

Placement of the county cell and project location symbol are accomplished by using the INDOT Tools
workflow.

1. With the INDOT Tools workflow open, select the County District Maps tool in the Cells tab.

ﬂ INDOT Tools 1= H IL& [f\ * % = pw:i\dotwise.indot.in.gov: DOTWise\Documents\Resources\CAD Sup
A Home Applications Cells otation Tools Survey Traffic

B [D|mM W ep s @gom B L0

Place Set Coun | Metric  Lighting Patterns  Pavement Signs Symbol Scale Tables-Legend-Motes MOT Professional
Cell Tool Active Scale=1 || District Maps| Ds ail Cells ells Cells ~ Markings Cells Cells™ “Cells  Bars ells Cells  Stamps
Cell Tools

Cell Libraries

County District Maps Tool

2. Within the Cell Library, navigate to and double left mouse click on the appropriate county or
counties.

X Cell Library: [e\users\psmock\dotwise. \IN_COU~1.CEL] - X
File
7] T
% & e iE X o060 [
& MName Description Type ~ 77
&= Knox Knox County Graphic | //
= KOSCIUS Kosciusko County Graphic
& LAGRANGE Lagrange County Graphic
2 LAKE Lake County Graphic
> LAPORTE Laporte County Graphic
= LAWRENCE Lawrence County Graphic
= MADISON Madison County Graphic
2 MARION Marion County Graphic
 MARSHA Marshall County Graphic
= MARTIN Martin County Graphic
= MAMI WMiami County Graphic
£ MONRAE Mnnrne Counte Granhie hd

Selecting a County

3. For8.5” x11” plans, you will need to set the X and Y scales to 0.50

ﬁ Place Active Cell - >

Active Celk
Active Angle: E
XScale )

¥ Scale £

[] Place as Shared Cell

Setting the X and Y Scales

4. Place the active cell by using the lower left corner of the Project Location box as your hook
point.
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PROJECT LOCATION SHOWN BY = -==-
$COUNTYS

DES. NO. $DES_NO$

Placing the Cell

To place the location symbol, use MicroStation based commands to copy the symbol from within the
Project Location box to its correct positioning.

PROJECT LOCATION SHOWN BY == .

Project Location Box
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5.2-1c Universal Title Sheet
The Universal Title Sheet is used to populate portions of the 8.5” x 11” Title sheet. This information
should only be edited using the Universal Title Sheet to ensure that that information is populated
throughout the entire set of plans. For further information on the ProjectWise attributes panel and how
to interact with it, please see the DOTWise 5.0 ProjectWise module.

The Universal Title Sheet is accessed within ProjectWise by selecting the Attributes Tab of the Properties
dialog box of the design file (.dgn) and ensuring that the Interface is set to  PROJECT INFORMATION

~| [P . i Interface|_pROJECT INFORMATION ~ | _  View|INDOT Defauit v|e
i) ira i

11350\Design\InRoads\Old Testing Data] ] ORD PrPlan.dgn - X
* | Name . 4 ; =
General Securty Aftrbutes  More Attibutes  Audit Trail  Work Space

#/®4alg INDOT_US_SVFT_20 ; )
A% |Bridge Layout 50 5caled | Universal Title Sheet ‘
# BidDesign.dgn PLAN TYPE 7]
/mDEsigrﬂ .dgn
/B Bxisting.dtm DESCRIPTION:  [Br Repl, Comp.Cont.Pres Conc.Bulb T-Beam |
o/ BMFicld Book 1_5510Test.d Bridge over US 41, 462 miles 5 of 70, SR 641 ramps over US 41 (SB). (PH IIA)

/IN_Signs_Warmng.dgn LOCATION:
/W4 INDOT_US_SVFT_2Dsee

/& JINDOT_US_SVFT_3Dsee AREAENG. CONTY.NO. [ |
# ZJ ORD PrPlan.dgn
/EHORD Survey Fieldbaok,g PHANS PREPARED BY | | prone nuMEER .
/&) ORD Survey Fieldbook | PROJECT ROUTE [PR 641 AADT. VED
< FROM RP TORP ATRP AADT. VPD.
Document Properties  Work Are. |M | |O'"I | ‘ | DHV VPH
Cl Properties (Work Area Tyl | proy. NO. CONST GROSSLENGTH  BRIDGE LENGTH S
DIRECTIONAL DIST
Designation Number ‘ | ‘ |
TRUCKS
Contract Number PROJ. NO.PE  NET LENGTH RDWY LENGTH
Survey Book ‘ | ‘ | I:I % DHV.
Project Number PROJ. NO. RW MAY. GRADE TOTAL_LENGTH ;
Brdge Fle [ | [ | [oowoo0 | ssenseEED| | wes
NBI Number BRIDGE FILE PROU DES CRT: | 3R (FREEWAY) v
Small Structure Detail Mumber _w STRUCTURE NO. _ﬂ3395
Project Rout . i FUNC. CLASS.: | LOCAL ROAD v
i oute
Location / District SPECDATE  COUNTY  SURVEY BOOK DESIGNATION RURALf urgax: |URBAN BUILT-UP)
e [oos vuse ] fom Jfocoraso ]
Design Type LATITUDE _ LONGITUDE ~ CONTRACT _PROJECT TERRAN:
Road Bridge Indicator N 0700 wo0o” R-28177 7654321 ACCESS CONTROL: | NONE ~
Managed By
Designed By

Update Project Properties
= Home Folder Properties

Save Undo Close I < 10/22 > >

Universal Title Sheet

See Chapter 2 for more information regarding use of the Universal Title Sheet.
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5.2-2 Ltr. Detail and Ltr. Landscape Detail
These sheet models are standard, empty 8.5” x 11” border sheets oriented in portrait and landscape.
This border sheet can be used for any drawing detail or table in a set of resurface plans.

While in the open file, import the sheet model titled Ltr. Detail Model from Ltr_Sheets.dgn. When you
open the newly imported sheet model, it will appear as shown below. Text outside of the border is
populated with the Universal Title Sheet. The title of the sheet is edited by changing the description of
the sheet model within the Model Properties dialog box. Draw or reference details into the area within
the border.

$539Vd TVL01$ 0 $WNN"3OVd$

rues

8.5 X 11 DETAIL BORDER - PORTRAIT 8.5 X 11 DETAIL BORDER - LANDSCAPE

$51_D1§

s SPAGE_NUMS of §TOTAL_PAGESS

Ltr Detail Sheets w/PE Stamp

5.2-2a Editing the Sheet Title
1. Within the file (you do not need to be in the target sheet model) open the Properties dialog for
the target sheet model by clicking on the Edit Model Properties button.

Type 20/3D Name Description ¢ Design File
(?_] L] Default ¥ chlusers\psm
[a 1 Ltr. Detail 2.3 %11 Detail Border - Portrait ci\usersipsn
| | Ltr. Detail with Stamp 2.5% 11 Detail Border - Por../Stamg « c\users\psn
[3 _|  Ltr. Detour Sheet Signing 8.5x 11 Recommended Detour 5., v c\users\psn
[ | Ltr. Landscape Detail 8.5x 11 Detail Border - Landscape chusers\ps|
E] Ll Lir. Landscape Detail with Stamp 8.5 x 11 Detail Border - L.../Stamp © chusersipsm
3 L1 Ltr. Title Sheet 8.5x 11 Title Sheet c\users\psi
| 1 Ltr. Index 8.5% 11 Index Border - Portrait  chusers\psh
8 I Ltr. Index with Stamp 8.3x% 11 Index Border - Port.../Stam| v c\users\psn

Edit Model Properties Button
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2. Inthe Properties dialog that appears, edit the description of the sheet model to reflect the title
of the drawing Detail.

Properties v 3x
4 Models (1)
IE Lir. Landscape Detail

General -~
Is Active False

MName Lir. Lands Detail
%mﬂm Typical Seclions I

ef Logical '

Type Sheet

Design Dimension 2D

|z Markup False

Annotation Scale Full Size 1=

Design Scale 1.0000

Paper Scale 1.0000

Propagate Annotation Sca On

Line Style Scale Annotation Scale

Update Fields Automatica False

Edit Description

3. The title change will be reflected in your sheet model.

§ o N T Ty

-1 0

2l L

TYPICAL SECTIONS

£
£
£

Changed Sheet Title
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5.2-3 Ltr. Detour Sheet Signing
This sheet model was set up to be used for the Recommended Detour Signing sheet. This sheet model is
pre-populated with a standard signing legend and uses the Universal Title Sheet to populate the route
into the title of the sheet.

While in the open file, import the sheet model titled Ltr. Detour Sheet Signing from Ltr_Sheets.dgn.
When you open the newly imported sheet model, it will appear as shown below.

e va 52

RECOMMENDED DETOUR SIGNING
FOR IR 1000 CLOSURE

A = Detour Route Marker Assembly

B - Road Closed 1o Thru Traffic

C - Detour Ahead

D - Road Closed Ahead, 1000' or 500"

\f E- XG205

O :;\ = $PAGE_NUMS of STOTAL PAGES$
Detour Signing Sheet

5.2-4 Miscellaneous Tables and Strip Maps
During the process of creating a set of plans on the 8.5” x 11” border sheets, you will need to add
various summary tables and or strip map.

5.2-4a Miscellaneous Tables
INDOT has provided a template Microsoft Excel file that contains several different tables that are
commonly used (and some not so commonly used) on resurface plans. These Excel tables have been
formatted to be cut/pasted into the provided sheet models at a 1:1 scale.

The Microsoft Excel Tables are available in ProjectWise at:

pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template Documents\Seed\Spreadsheets\
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Instructions for each table are included on each sheet within the Microsoft Excel file. Once completed,
the tables can then be copied and pasted into a MicroStation sheet model.

Copy and Paste Tables into Sheet Model.

1. Complete the Excel spreadsheet and select the area that you wish to copy into a sheet model.

Then either Right Click = Copy with your mouse or enter Ctr/ + C on your keyboard to copy that

information.
c3 M 5 STRUCTURE DATA
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1
1
A Cut
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. ':é‘ Explorer
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|—£| Attach Tools ~ F@"j Level Manager ~ @ Mare ~
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In the target sheet model, select the Paste tool from the Home tab of the Drawing workflow:

pw:\\detwise.indot.in.gov:DOTWise\Documents\Resources\CAD Support\Working Folders\P
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|—£| Reference =

= Level Display ~
Primary

v b 0 X Properties

Drawing Aids

(@ Properties

Element
Selection

Content

N T@

y
B

Selection

v B Ix

u 8 Models (1) I

Lo
Fence
Tools =
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Place  Place _ Arc .
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Paste Excel Data into the MicroStation Platform from Excel

| Paste (Ctrl+V)
Paste elements from clipboard




3. Select the area in which you want to paste the table in the sheet model using tentative snaps.
This will paste a picture of the table in the sheet model. This image is not editable. To edit the
table, you will need to edit the spreadsheet file and then repeat the copy — paste operation.

STRUCTURE DATA
3 [ITaT,

DESLTOA W = FLOW LFE N 1 ~1= = | ®

Copied Excel Table

Due to ProjectWise functionality, it is highly recommended that users do not embed or link Excel sheets.
There are two major issues that make these processes undesirable:

e Embedding — With an embedded spreadsheet, the CAD file must be open and then the Excel
content opened from within the DGN. Additionally, one cannot link data across sheets with
embedded Excel content.

e Linking — Due to the way ProjectWise functions with unique working directories for all users,
linking will not work for any users other than the link creator.



Additionally, as part of a set of Resurface Plans, per the Indiana Design Manual, a Strip Map is required.

5.2-4b Strip Maps

This should also be created using the Ltr. Detail or Ltr. Landscape Detail sheet model(s).

Examples of a typical Strip Map are shown here.
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http://www.in.gov/indot/design_manual/files/INDOT_CAD_Standards.pdf

5.3 Traffic Plans Production

5.3-1 Signs Signals and Lighting Plans
The following sections discuss MicroStation Platform resources to be used in the development of a set
of Traffic plans for Signs Signals or Lighting.

Traffic plans will normally start from the INDOT US SVFT 2Dseed.dgn seed file located in ProjectWise.
For more recent surveys, a geocoordinated version of one of these files will be found in the Survey
Project Files folder.

Q ProjectWise Explorer

Datasource Folder Document View Tools Window Help

P o 5 | & | Dp 2p :E:E (7] ;i 44 - SearchL;Ez v|b;  Interface|_PROJECT IN

¢l - I:D - l!lj' Addresslg‘i pwilindot-pw.bentley. com:iindot-pw-01\Documents\Crawfordsvill 4, 1800570 5urvey\Project Files\1800570_51 \/| b Go =
=-{% 1800570 A List @ Spatial

[j--f_" Construction

) . . MName
gt" ;Z:;:gmearmg ofindians Inc. ./‘jg“wwm_smm SURVEY ALIGNMENTS.alg
(% Environmental Services /ﬂWOOS?O_SREET Survey Fieldbook.dgn
G- [ Geotechnical /a13005?0-5ﬂ26?-?00N EXISTING TERRAIMN.dtm
[#-[* Parsons Transportation Group, Inc # ) esri_cad.wld
L™ Pavement Design # | IN_GeoCS.dty /
5[ Project Management A& INDOT_US_SVFT_2Dseed.dgn
-{% Review A& INDOT_US_SVFT_3Dseed.dgn
[—jt__" Survey
L. _Raw Data <

1o COGo Document Properties  Work Area Propetties  Folder Properties  Personial Portal  Photo Preview  Navig

- Consultant Files
1= Documents <Defautt> >
L' ERPI\:SSubm\ttals Property name Property value
L' Name 1800570_SR267 Survey Fiel
- Images X
L Project Files Fold.er Mame Project Files

Example Geocoordinated Seed Location

The previous screen capture shows an illustration of where you might find the geocoordinated seed files
if your project has been setup. This should be the first location where seed files should be located. If
there is no survey data and the project has not been geocoordinated, the files will need to be selected
from the Template Documents location shown below. Regardless of which file is being created, it is
highly recommended to use the Advanced Document Creation Wizard.

Additional seed files can be found at pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template
Documents\ORD-Connect Seed\ in the event an appropriate seed has not been provided.

Note: For information on creating documents from the appropriate seed files in the DOTWise system,
please see the INDOTWise 5.0 DOTWise ProjectWise module with discussion on the procedure, and
section 1.1 CAD Seed/Template Files for specific information on the files that should be used.
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5.3-2 Traffic Plans Creation
With a template document now created, the Traffic Plans can start being assembled. The first portion of
the Traffic Plan composition is the creation of the project title sheet. The first method of creation will be
from pre-existing plan images.

5.3-2a Creating the Design from As-Built Plan Image
To start this process, first go back to the DGN that was created earlier in this section, Des#_Traffic Signal
Plans.dgn. Open the file from ProjectWise and switch to a new model. For more details on
creating/editing models, please refer to Appendix C of this document, or the application help file.

In a new model, start by opening the Raster Manager. This can be found in the Attach Tools dropdown
under the Home tab of the Drawing workflow.

ﬂ IDrawinE ' I'f‘ H tx:g EC: * lgl -
View Annotate Attach Analyze Curves Constraints Utilities Drawing A

[E] Reference ~ @] Properties

=& MNone T || Default =
— fa: Level Manager @ More =
10 A =0 "= 0 4 0 v || 0 - .
F = o & = [E] References Level Display ~
Attributes 'E Raster Manager IPrimar}r

Explorer v AX Po {3 Point Clouds

) Reality Mesh

¥ Items v

Start Raster Manager

After initiating the Raster Manager, the Raster Manager dialog will be displayed. On this dialog, select
the Attach > Raster... command from the File menu:

EH Raster Manager: 0 of 0 listed — X
Edit View Display Settings Tools Utilities

N » o .y .7 > B OO A
= g S & E‘—" cir B b A @ O
| Attach 4 Raster... | A
Description B Model
Detach 5§ WMS...
Detach All Eﬁ From Image Server...
Reload “1‘5 ECWP Image Server...
Save As... Gﬁ Bing Maps...
4§ Attach Raster Grid
Export 4
Import 4

Batch Convert

Attaching a Raster



Next, locate the scanned/PDF copy of the As Built Plans for the project. As with most other project
deliverables, these should be uploaded to ProjectWise for easy location, management, and security.

=l
Lookin: [ B Deskdon - er @ & BEa|

Neme ~ |~|sze || rtemtype || Datemodified [ +| | Preview
E- |i=|tL.jpg 43KB JPEG image 10/6/2014 10:25 AM ¥ Raster Preview
PO ISR 62(4th 51) &Plaza ... 125KB Adobe AcrobatDo...  5/15/2014 1:06 PM

(@) PW Server Files - Shor... 1KB Shortcut 1/30/2014 7:18 AM
] 64h\t CAD installs 3KB Shortcut 9/25/2014 7:10 AM

Desktop etwork
18 Computer

JA Robison, Scott (INDOT)
P | 5 braries

(s
Computer

Network

3456 X 2325, RGB
<no georeference >

¥ Place Interactively
¥ Open Settings Dialog

File riame: [5R 6204 5 & Plaza Drpd | Open
Flesoftype:  [Common Raster Fomats = Cancel
[¥ Open as read-only

Locating the As Built Reference

During the attachment process, make sure that the Raster is attached at a 1:1 scale. It is very important
that the raster be attached this way to determine the necessary scale factor to rescale the raster by.

At this time, scaling of the As Built needs determined to draft the elements true scale. To determine the
scale, locate some of the dimensioned elements on the raster and measure them using the application
measurement tools.

_::I 1 Measure Distance

A\ 2 Measure Radus [
_é—u 3  Measure Angle A
E 4 Measure Length

£ B Measure Area Q_’?I
£ §  Measure Volume Far
= Open as ToolBox

Measurement Tools
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To determine the scale factor needed to upscale the raster by, take the as dimensioned measurement
from the drawing and divide it by the measured value using the tools. For example, the following
illustration shows a dimensioned line that is listed at 19.5’. The MicroStation tools measured this to be
displayed as 0.0752’. To calculate the scale factor, divide the dimensioned by the measured
(19.5’/0.0752’) resulting in a scale factor of 259.31.

I =l

<, Raster Manager : 1 of 1 listed

Edit_View Display Settings  Utiiities.
EEEN T TR ERY IO
N\ B [tode /| |

s File Name [ Description

' DPEDEEEE [SEME= Ly

Method _Adive Scale ¥
X Scale mj
Y Scale: [753310000 —b
ZScale: 59310000

LFPAN AN
AT ERNARY

< P S

/

Raster Scaling

With the raster now scaled properly, one can now start drafting based on the As Built raster. Using the
standard MicroStation drawing and Level tools, trace the geometry on the appropriate levels as
provided in the DGNLib. These levels include the TRAF_ prefix and can be filtered using the DGNLib
filters as shown.
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Eﬁ
Levels Fitter Edit
':’g % - | Symbology: |Bylevel ~ {none) = M A
7 Standards [IN_Symbology]  * | A Name
7 Survey [IN_Symbology] E_S_
7 Text Levels [IN_Symbology] E_TRAF_Lighting
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= Busting S_TRAF_Amow left tum...
= Proposed 5_TRAF_Amow leftstra...
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< > S_TRAF_Amow straight ..
Active Level: Default

Traffic Proposed and Existing Filters
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Attributes [

Setting the Active Level, Color, and Linestyle

Once completed tracing the As Built information, the Raster Image can be detached. Do so by opening
the Raster Manager, and highlighting the As Built, and either Right Click -> Detach, or from the File ->
Detach menu option shown below.

=fl Raster Manager: 1 of 1 listed
| File Edit View Display Settings Utiities
»

el B LEY
m_ ) Descrimq

Detach All
Reload

Save As...

Import (3

Batch Convert

NBERERER [CoE= [

Detaching a Raster

At this point, the Traffic Plans should be completed using standard MicroStation tools. Later in this
chapter, a review of sheet creation will occur. First however, brief explanations of alternate plan
creation methods will be discussed.

5.3-2b Creating Traffic Plans Without As Builts
In many projects, it is quite common to start a project without any As Built data. In this instance,
alternate sources of data can be used to have a raster image background from which the geometry can
be traced.

As with the previous section, start by creating a new model. Once prepared, start the Raster Manager
as discussed in the previous section.

In this instance, an As Built will not be available. In lieu of this, the INDOT GIS department has made
available a listing of WMS Web Map Services. These map services were discussed previously in section
3.1 Introduction to WMS, however a brief overview of the attachment process is provided here.



The first step is to select the File -> Attach -> WMS:

B Raster Manager: 0 of 0 listed - x
Ifile Igmt View Display Settings Tools Utilities
: = s e
e O E-Bt R AE®Ie PAsd@0
iz P|E_Raster.. Description B Model
Detach Cg| WMs...
Detach All From Image Server...
Reload %3 ECWP Image Server...
Save As... G Bing Meps...
g Attach Raster Grid
Export »
Impert >
Batch Convert
12]3]4]s]e]7]e] = @ EE Tt [ Transparency: B

Attaching a WMS Map

On the presented Attach Raster Reference dialog, navigate to the XWMS folder in ProjectWise. This
folder is located at:

pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Resources\XWMS\

Select the CADStreetAnno.xwms, and the Current Indiana Statewide Imagery.xwms and select OK.
Please note that the GIS staff is constantly acquiring and processing new imagery, so newer versions of
these maps may be available, especially the Full Res images. Check often if new images have been made
available.

Note: When using the rasters, the following issues may be encountered:

1. Each set of rasters has benefits and disadvantages, use the Orthos that fit your project needs for
the best experience.

2. The plotting of raster images within 3D models presents some known issues. If you know you
will be plotting such images for use on plan sheets, only use a 2D seed file when creating your
base sheets.

E’J Attach Raster Reference

Select

Documents

Folder |[: KWMS

R

MName Description

# ] 2005 Statewide Imageryxwms 2005 Statewide Imagery

/] 2011_2013 Statewide Imageryxwms 2011_2013 Statewide Imagery

Z Best Available Imagery.xwms Best Available Imagery

/3 CADStreetAnnoxwms CADStreetfnno

# | Current Indizna Statewide Imageryxwms Aerial imagery, statewide Indian...

| Most Recent Available Imagery.xwms This is not survey grade and sho...
-

WMS Raster Attachment
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With the images now attached, MicroStation will start streaming the images based on where your view
is located. Itis highly recommended to zoom all the way out, so the entire state map is visible, and then
Zoom down to the intersection.

With the location of the intersection found, go back to the Raster Manager. Highlight the
CADStreetAnno.xwms, and then select Display -> Bring to Front from the Raster Manager toolbar.

m Raster Manager: 2 of 2 listed

File Edit View] Display | Settings Teols  Utlities

TE:E - lE E|+ | Erin:_:’o:o:t | E;?
@ @ File e T RaE Descriptio
o Bring Forward
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o CADStreel Align View to Raster
j Fit Rasters To View

Fit All Rasters To View
Actual Resolution (1:1)

Enhance Binary

Annotations 3

Bringing the CADStreetAnno.xwms to the Front

At this time, the extraneous raster imagery needs cropped out. Select the Clip tool from the Raster
Manager toolbar and then crop the rasters to just the needed area.

E Raster Manager: 2 of 2 listed — x

File Edit View Display Settings Tools Utilities

w _Nhe e
k= -] A2400
il Q File Name Description B Model
i
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!
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4% Clip - X
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[] Work in Image Plane

Use Fence

£
EEHEEHE g Tint: D Transparency: -

Raster Clipping
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Clipped Raster

Next, the rasters need to have their geolocation enabled so they display in the correct spot on the DGN.
To do so, view the Properties of the rasters, and set the “Inherit GeoCS from Model” setting under
Geometry > Geocoding to Not Inherited (as shown below), so that image falls into place.

Properties v 1x
4 Y Elements (1)

! Best Available Imagery.xwms

| General -
=m=5) -
Geo Priority Raster Header
Aspect Ratio Unlocked
» Origin 1299334.2982°. 13706225
» Corners
» Pixel Size
> Scale
> Dpi
» Dimension
»  Mumber of Pixels
» Rotation
=
Mame EPSG:26916
Description NADSE3 / UTM zone 16N
Inherit GeoCS from Model | [ QI P=HE]
R ot Inherited
Extended Inherited

Setting the GeoCS to Not Inherited

At this point, the plan development process is the same as in the previous example. Trace the geometry
using the appropriate symbology and detach the rasters when completed.
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5.3-2¢ Traffic Plans when Survey or Design Data is Available
In this instance, the traffic plans process will start from pre-existing data directly in a MicroStation
format. As was discussed earlier in this chapter, the first place to look for a seed file in this instance will
be under the Survey\Project Files folder for the project.

At this time, the Survey Geometry can be used directly from the TOPO drawings. Note that there are a
variety of methods to get and use this data:

e The data can be referenced and traced.
o The data can be referenced and merged.
e The data can be referenced and copied directly.

Depending on the method chosen, the data must be modified to the appropriate symbology for Traffic
Plans and the development process can occur.

The above processes are also valid when working on Traffic Plans that are part of a broader Design
project. In this instance, instead of using the TOPO, the pavement markings will be used in the same
fashion listed above.

At this point for all 3 methods, it is time to take the created Traffic Plan and place it appropriately in a
MicroStation border.

5.3-2d Creating the Detail Sheet
The final step for completing the Traffic Plans is the creation of the Detail Sheet for the project. Working
out of the Signals Plan drawing, import a separate Arch D size sheet model using Models tool with
appropriate sheet border. These borders can be found in the D size sheets.dgn located in ProjectWise.

£ Import Model From File X
Select

Folder
[ pen Ve B EER
# 2 'S
Document

Name

_/:J Consultant_Ltr_sheets.dgn

./ D size_sheets.dgn

_/:J Ltr_sheets.dgn

< >
Address: ‘pw:‘\\;Iotwlse.|ndut.\n.gov:DOT\N’\se\DDcuments\INDOT Workspace\Development\ORDY |
Description: ‘ Current INDOT D-Size MicroStation Sheet Models |
File Name: ‘ D size_sheets.dan |
Application: All Applications w
Extension: *dgn w

Open document as read-only
Open Cancel

Locating the D_size_sheets.dgn
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With the border file located and opened, select the appropriate border from the list to Import into the
Open dgn. For example, the SG_Detail Sheet.

&4 Select Models *

File: | D size_sheets.dgn

Type 20/30 MName Description 2
[ ) RD_Title Sheet ROW Road ROW Title She

Ll RSM Prelim Drawing Sheet RSM Prelim Drawi et

5G_Detail Sheet Traffic Signals Detail Sheet
5 I SG_Title Sheet Signals Title Sheet
[ ) SL_Plan Sheet Signs and Lighting Plan Sheet
[ | SL_Title Sheet Signs and Lighting Title Sheet
[8 ) SM_Index Sheet Signs Index Sheet
[ _J SN Sheet Sign and Post ...  Sians Sheet Sian and Post Summary Sheet ¥
< >

Selecting the Detail Model

This will bring a copy of the model into the active drawing. Select this newly imported model and open
the Reference Attachment dialog from the Home tab of the Drawing workflow:

& | Drawing JodBR -+ 88 -
View Annotate Attach Analyze Curves Constraints Utilities Drawing Ai
@ [None | Default . %‘ Explorer @ Reference |~ @5 Properties

. @ Attach Tools ~ % Level Manager ~ @ Maore =
|| == v || = - * || M - i
Qo ~||= 0 =0 Q@0 =10 Models * == Level Display ~

Attributes Primary

Attaching a Reference
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Next, reference in the model containing the Intersection design as required to the appropriate scale (1”-
20’ or 1”-30’ as per IDM). Note that an alternative method would be to drag and drop the model from
the Models dialog to the References dialog.

£ Attach Reference X
Select
Documents
Foider [ (= ps Yew| EEIR
LY

MName 2

/4 Control Code.dgn

/™4 Cross Sections EB_2D.dgn
E Des# _Traffic Signal Plans.dgn
./ MYINDOT_Traffic Sign Poster Test.dgn

M4 INDOT_US_SVFT_3Dseed.dgn v

< >
Application: All Applications -
Extension: *.dgn; *.dwg; *.dxf -

Add Remove

Selected Documents

MName Description File Name Folder Storage Storage FolderId  Version Sequence
Attachment method: Interactive ~

Intersection Attachment

This concludes the Traffic Plans development process. At this time, the final file is prepared for plotting
using the tools discussed in INDOTWise 5.0 Plotting manual.

5.4 MicroStation Drawing/Model Names

See the tables in this section for the recommended naming convention for various type of DGN
drawings/model names. Please keep in mind that these can be applied to individual DGN models when
one does not create a DGN for each file type.

Note: Please abbreviate DGN/model names as needed using the INDOT standard abbreviations (i.e., Sht
— Sheet, MOT — Maintenance of Traffic, etc).

In the tables below, “nn” is used to denote the drawing number when there are multiple DGN'’s (or
sheet files) for the same type of drawing. Users should note that it is acceptable to create multiple
sheet models within a single DGN, thus eliminating the need for multiple DGN’s with the same
description/drawing file name.
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Description Drawing File Name Examples
Road Project
Title Sheet Sht Title.dgn

Drawing Index and General
Notes

Sht Index.dgn

Typical Cross Sections

Sht Typical_nn.dgn

Sht Typical_07.dgn

Survey Route (Plat No. 1)

Sht Platl_nn.dgn

Sht Platl.dgn
Sht Platl_05.dgn

Survey Route Plat with Aerial
Photography (Plat No. 3)

Sht Plat3_nn.dgn

Sht Plat3.dgn
Sht Plat3_05.dgn

Geometric Tie-Up

Sht Geometric Tie_nn.dgn

Sht Geometric Tie.dgn
Sht Geometric Tie_01.dgn

Traffic Maintenance Details

Sht MOT_nn.dgn

Sht MOT 02.dgn

Plan and Profile

Sht PlanProfile_scale_nn.dgn

Sht PlanProfile_50_01.dgn

Superelevation-Transition
Diagram

Sht Super_nn.dgn

Sht Super.dgn
Sht Super_01.dgn

Details

Construction Details

Sht Const Detail_scale_nn.dgn

Sht Const Detail 30 _01.dgn

Intersection Details

Sht Intersection_scale_nn.dgn

Sht Intersection_30_01.dgn

Spot Elevation Details

Sht Spot Elev_nn.dgn

Sht Spot Elev.dgn
Sht Spot Elev_01.dgn

Channel Details

Sht Channel_nn.dgn

Sht Channel_01.dgn

Geometric Details

Sht Geom Detail_nn.dgn

Right-of-Way Details

Sht ROW Detail_nn.dgn

Sht ROW Detail.dgn
Sht ROW Detail_01.dgn

Grading Plan

Sht Grading_scale_nn.dgn

Sht Grading_30_01.dgn

Drainage Details

Sht Drainage_nn.dgn

Sht Drainage_01.dgn

Erosion and Sediment
Control Details (plan view)

Sht TEC_scale_nn.dgn

Sht TEC_30_01.dgn

Retaining Wall Details

Sht Retaining Wall_nn.dgn

Sht Retaining Wall.dgn
Sht Retaining Wall_01.dgn

Wetland Mitigation Details

Sht Mitigation_scale_nn.dgn

Sht Mitigation_30_01.dgn

Traffic-Work Details

Signs (if separate traffic-sign
plans are not required)

Sht Signs_nn.dgn

Sht Signs.dgn
Sht Signs_01.dgn

Signals

Sht Signal_scale_nn.dgn

Sht Signal_30_02.dgn

Lighting (if separate lighting
plans are not required)

Sht Lighting_nn.dgn

Sht Lighting.dgn
Sht Lighting_01.dgn

Pavement Markings

Sht Pvmt Markings_scale_nn.dgn

Sht Pvmt Markings_30_03.dgn

Road Summary Sheet

Sht Road Summary.dgn

Description Drawing File Name Examples
Bridge Project

Title Sheet Sht Title.dgn

Index Sht Index.dgn

Typical Cross Sections

Sht Typical Cross Sections.dgn

Traffic Maintenance Details

Sht MOT_nn.dgn

Sht MOT_02.dgn
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Traffic Detour Details

Sht Detour_nn.dgn

Temporary Runaround
Details

Sht Runaround_scale_nn.dgn

Sht Runaround_50_02.dgn

Road Plan and Profile

Sht PlanProfile_scale_nn.dgn

Sht PlanProfile_50 _01.dgn

Superelevation-Transition
Diagram

Sht Super_nn.dgn

Sht Super.dgn
Sht Super_01.dgn

Roadway Details (see Road
Plan sheets)

Traffic-Work Details (see
Road Plan sheets)

Soil Borings Sht Borings TB_nn.dgn Sht Borings TB_01.dgn
Channel Change Layout Sht Channel_nn.dgn Sht Channel_01.dgn
Layout Sht Layout_scale_nn.dgn Sht Layout_30_01.dgn

General Plan

Sht General Plan.dgn

Structure Details

Sht Structure.dgn

Abutment/Bent/Pier Details

Sht End Bent Details_nn.dgn
Sht Pier No x_nn.dgn

Sht End Bent Details_02.dgn
Sht Pier No 2 and 3_01.dgn

Framing Plan

Sht Framing Plan.dgn

Structural Steel Details or
Precast-Concrete Beam
Details

Sht Beam Details_nn.dgn

Sht Beam Details_01.dgn

Bearing Details

Sht Bearings.dgn

Superstructure/Floor Details

Sht Superstructure_nn.dgn

Sht Superstructure_02.dgn

Railing Details

Sht Railing Details.dgn

Screeds

Sht Screed_nn.dgn

Sht Screed_02.dgn

Reinforced-Concrete Bridge
Approach Details

Sht Approach Slab Details nn.dgn

Sht Approach Slab
Details_02.dgn

Bridge Summary

Sht Bridge Summary.dgn

Road Summary

Sht Road Summary. dgn

Pipe Materials

Sht Materials.dgn

Cross Sections

Sht Xsec_scale_nn.dgn

Sht Xsec_50_03.dgn
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Sheet Sign Layout_nn.dgn

Description Drawing File Name Examples

Traffic-Signs Project

Title Sheet Sht Title.dgn

Index and General Notes Sht Index.dgn

Signing Plan Sht Signing Plan_nn.dgn Sht Signing Plan_01.dgn

Sign Layout Sht Panel Sign Layout_nn.dgn Sht | Sht Panel Sign Layout_01.dgn /

Sht Sheet Sign Layout_01.dgn

Cross Sections

Sht Sign Cross Sections.dgn

Sign Summary

Sht Panel Sign & Post
Summary_nn.dgn
Sht Sheet Sign & Post
Summary_nn.dgn

Sht Panel Sign & Post Summary
_01.dgn

Sht Sheet Sign & Post
Summary_01.dgn

Footing Details

Sht Signal Footing Details.dgn

Structural Details

Sht Structural Details.dgn

Signalization Project

Title Sheet

Sht Title.dgn

Index and General Notes

Sht Index.dgn

Signal Plan

Sht Signal Plan.dgn

Sht US 41 & SR 57 Signal
Plan.dgn

Signal Details Sht Signal Details.dgn
Lighting Project

Title Sheet Sht Title.dgn

Index and General Notes Sht Index.dgn
Lighting Plan Sht Lighting Plan.dgn

Cross Sections

Sht Lighting Cross Sections.dgn

Lighting Details

Sht Lighting Details.dgn

The following tables spell out the standard naming conventions for standard base drawings and sheet

drawings, respectively.

Standard Base Drawings

Drawing Names /
Logical Names

Descriptions /
Reference Descriptions

Examples

Survey Alignment

Survey Centerline

Survey Alignment.dgn

Survey Section Corner

US Government Section
Corners

Survey Section Corner.dgn

Survey Contours

Survey Existing Contours

Survey Contours.dgn

Survey Topography

Survey Existing Topography

Survey Topography.dgn

Survey Triangulation

Existing Triangulation

Survey Triangulation.dgn

Explan scale

Design Existing Topography

Explan 50.dgn
Explan 100.dgn

Design Alignment

Design Alignment

Design Alignment.dgn

Prplan scale

Proposed Design Strings

Prplan 50.dgn
Prplan 100.dgn

RW Existing scale

Existing Right of Way

RW Existing 50.dgn




RW Existing 100.dgn

Annotate Alignment LineB | Proposed Alignment Annotate alignment LineB 50.dgn
scale Annotation Annotate alignment LineB 100.dgn
Annotate Survey Survey Alignment Annotate survey alignment LineB
Alignment LineB scale Annotation 50.dgn
Annotate station offset Annotation of Survey Annotate station offset LineB 50.dgn
LineB scale points with station and

offset
Annotate survey points Annotation of Survey Annotate survey points LineB 50.dgn
LineB scale points

Standard Sheet Drawings

Drawing Names Descriptions Examples

Planprofile LineB scale n Plan & profiles drawings Planprofile LineB 50 001.dgn
PlanProfile LineB 50 002.dgn
PlanProfile LineB 50 n.dgn
Layout LineB scale n Bridge layout sheet Layout LineB 50 001.dgn
Layout LineB 50 002.dgn
Layout LineB 50 n.dgn

Const det LineB scale n Construction details Const det LineB 50 001.dgn
drawings Const det LineB 50 002.dgn
Const det LineB 50 n.dgn
Pvmt Markings scale n Pavement marking details Pvmt Markings 50.dgn

Pvmt Markings 50 01.dgn
Pvmt Markings 50 02.dgn
Pvmt Markings 50 n.dgn

Runaround LineB scale n Temporary Runaround plan | Runaround LineB 50 001.dgn
profile drawings. Runaround LineB 50 002.dgn
Runaround LineB 50 n.dgn
TEC det LineB scale n Temporary Erosion Control | TEC det LineB 50 01.dgn
details TEC det LineB 50 02.dgn
TEC det LineB 50 n.dgn
Intersection Det scale n Intersection details Intersection det 50 n.dgn

For the sheet drawings shown above, the alignment name, scale, and sheet number indicate which
alignment, scale, and sheet number is reflected. Following this convention will allow easy
differentiation between alignments and scales.
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6. Working with References in the MicroStation Platform

This chapter will cover how to work with references in the plans production process. With the emphasis
on the use of models in our plans production process, it is very important to understand how references
are used to create design/sheet content.

6.1 Using References

Elements in a reference display as though they were in the active model. Although you cannot
manipulate the elements in a reference, you can snap to them and even copy them into the active
model.

The most common usage of references is in the creation of design compositions. Design compositions
are used by engineers and other technical professionals to communicate through the visual content of
their designs.

To create a design composition using MicroStation, you build a design model consisting of a working
collection of references used in the performance of particular engineering tasks. For example, you may
attach as references a collection of survey points as a guide for placement of additional geometry.
Reference attachments in a design composition are usually coincident.

It is sometimes convenient to refer to one part of a model while drawing in another area by attaching
the active model to itself.

Another common usage of references is in the creation of drawings for publication. This task is called
drawing composition. Whereas a design composition is typically contained in a design model, a drawing
is composed in a sheet model.

6.2 Attaching References

The most common way to attach a reference is to attach it with a Coincident — World orientation. This
means that the global origin of the reference file will be matched to the global origin of the active file.
With this orientation chosen, when a user snaps to elements in the attached reference, the coordinate
information will be correct. To attach a reference with Coincident — World orientation, perform the
following steps:

1. Inthe active file, click on the Attach Tools button in the Primary tool group of the Home tab in
any workflow.

ﬂ OpenRoads Modeling v v H l‘._ltf ilfl ; = Lo fg =
m Home Terrain Geometry Site Cormdors Model Detailing Drawi
& |Mone * || Default = Q |- B -=
Attach | = 7=
- = v || — - — — ac )
[=0 =R =0 @0 &0 Explorer Tools ~ |72 ~ O ~

Attributes Primary

Attach Tools
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2. Onthe References dialog that appears, click on Tools > Attach. Alternatively, you can click on
the Attach References button, or you can right-click in the Hierarchy or reference listing panes
and choose the Attach option from the menu that appears.

|
B| References (2 of 2 unique, 2 displayed)

Tools | Properties

g -
[ Atech.. | ] A7 ; i i g
DA 7 |F_| References (2 of 2 unique, 2 displayed) Siot “ 3 File Name Model
e Slot 7 [ PW _W..\ORD Survey Fieldbook July 22.dgn _ Default
Detach All Detault Tools P ot 2 ORD_PrPlan _July 22.dgn Default-30
i Default] | ([ 1__ Tools _ Properties
Reload ] — = 3 ( 5 Attach...
Reload All - ‘ ﬁ | y 1 o Detach
— T I T s - Reload
Exchange 5 ~
. ot Exchange
Open in New Session Open in New Session
Activate 1 Activate
Deactivate 2 Deactivate

Options to Attach a Reference

3. On the Attach Reference dialog that appears, select the DGN file that contains the model you
want to reference into the active file.

lﬂ-:'f: Reference |
Select
Documents
|
| alr -|>
| Name o
i ORD_PrPlan_uly 22
/Eﬂ ORD_Survey Alignment.dgn
/E’J ORD_Survey Fieldbook_luly 22
/ﬂ routeplat_US_SVFT.dgn ]
< >
Application: All Applications ~
| Extension: *.dgn w
Add Remove
Selected Documents
MName File Na
< >
Attachment method: Interactive ~
OK Cancel

Attach Reference Dialog

4. On the Reference Attachment Properties dialog that appears, note the Model setting. By
default, the reference’s master model is selected. If the model you want to reference into the
active file is NOT the master model, select it from the dropdown list.

5. Inthe Orientation section of the dialog, select the Coincident — World orientation if it is not
already selected.
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6. With the correct model and orientation selected, click OK to proceed with attaching the
reference.

E’J Reference Attachment Properties for ..\ORD_Survey Fieldbook_July 22.dgn *

File Name:  PW_WORKDIR:d07766454ORD_Survey Fieldbook_uly 22.dgn
Full Path: ..\pw_work\d0776645\0ORD_Survey Fieldbook_July 22.dgn
Model:: Default

Logical Name: | Ref-1 I

Description: | Master Model |

Orientation:
View Description
Coincident Aligned with Master File
oincident - Wo ol rigin aligned w er File

ulated Transform, max error 0.0003663
ject reference data to Master GCS

Geographic - AEC Transform

Geographic - Reprojected
Standard Views

Saved Views (none)

Mamed Boundaries (none)

Detail Scale: |1"=30' |
Scale (MasterRef): [1.000000000 | : |1.000000000 |
Mamed Group: -
Revision: -
Level: | v|

Nested Attachments: | Live Nesting | Nesting Depth: 0 |
Display Overrides: | Allow |
New Level Display: | Use MS_REF_NEWLEVELDISPLAY Cor |
Global LineStyle Scale: | Master |
Synchronize View: |Volume Only =

Toggles

I - [ -

Reference Attachment Properties Dialog
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6.3 Working with Nested References

When a MicroStation platform-based design file being used as a reference has its own attachments, they
become nested references. The links between these files can be maintained through many levels
(depths) of nesting, so that if you open only one file, you can view the contents of many files. The
individual references can be updated, and the changes will be shown in the master (or parent) file.
When you attach a parent reference to your model and turn on live nesting, you can also control how
many levels of nested references are attached to the model.

To attach a reference with live nesting turned on, perform the following steps:

1. Perform steps 1 through 3 from the previous section to open the References dialog and select
the file containing the model you want to attach to your active file.

2. Onthe Reference Attachment Properties dialog, note the Nested Attachments setting. If not
already selected by default, select the Live Nesting option.

3. Forthe Nesting Depth setting, enter an appropriate value such that it properly encapsulates all
of your nested references.

File Name:  PW_WORKDIR:d07766454ORD_Survey Fieldbook_luly 22.dgn
Full Path: ..\pw_work\d0776645\0RD_Survey Fieldbook_July 22.dgn
Model: |[Default -
| Logical Name: | Ref-1

Description: | Master Model

Orientation:

View Description

Coincident Aligned with Master File

Coincident - World
Geographic - AEC Transform
Geographic - Reprojected
Standard Views
Saved Views (none)
med Boundaries (none)

Global Origin aligned with Master File
Calculated Transform, max error 0.0003663 '
Reproject reference data to Master GCS

Detail Scale: |1"=30"
ale (Master:Ref): | 1.000000000
Mamed Group:
Revision:

Level:

1.000000000

=

Iﬂested Attachments: | Live Nesting

< ‘IINe;ting Depth: | 10

Display Overrides: | Allow

-

New Level Display: |Use MS_REF_NEWLEVELDISPLAY Cor

Global LineStyle Scale: | Master

Synchronize View: |Wolume Only

Toggles

B =

-

-

He @@

Nested Attachments and Nesting Depth Settings

Once the reference is attached, pay attention to the Hierarchy pane of the References dialog. Note the
hierarchical structure of this pane, as it is helpful to visualize the current nesting that is in place.
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E| References (2 of 2 unique, 2 displayed)

Tocols  Properties

BB xe £9¢Earm
Hierarchy
= QRD_PrPlan_luly 22.dgn, Default
PW_WORK.\NORD_Survey Fieldbook_July 22.dgn
Ref, QRD_PrPlan_luly 22.dgn, Default-3D

Hierarchy Pane of References Dialog

The Nested Attachments and Nesting Depth settings will be explained below in more detail.
Nested Attachments

This setting determines if referenced models attached to reference models (and so on) are recognized
when a model is attached to the active model.

e No Nesting — Models attached to the attached model are not recognized in the active model.
e Live Nesting — Models attached to the attached model are recognized in the active model.
e Copy Attachments — Models attached to the attached model copied into the active model.

When working in a DWG or DXF file, live nesting is always on, and there is no limit to nest depth.
Therefore, the Nested Attachments and Depth items are disabled. To control the display of nested
attachments, use the Ignore Attachment When Live Nesting setting (on the Attachment Settings dialog
box).

Nesting Depth

The Nesting Depth setting sets the number of levels of referenced models that are recognized. Models
can have their own referenced models, which, in turn, can have more referenced models, and so on.

If the depth is set to 0, only the selected reference model is attached to the master model; referenced
models in the referenced model are ignored.

Note: Care and understanding of how your nested references are configured is very important. Due to a
known defect that CAD Support has brought to Bentley’s attention, entering an arbitrary high value for
this setting could produce duplicated displays of your references in the plan sheet creation process.
More information on this issue can be found in the INDOTWise 5.1 ORD Plans Production document.
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